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Preface

This user guide:

e Describes requirements on how to configure RAID mode on AMD platforms.
e Provides information about arrays, disks, and RAID levels (RAID types).

e Describes how to improve storage system performance or reliability by understanding
array and disk tasks and options.

e Describes the procedures on how to acquire and load RAIDXpert2 drivers for supported
Microsoft® Windows® operating systems and Linux® operating systems.

e Describes supported features and procedures for using RAIDXpert2, which is the
RAIDXpert2 GUI.

Intended Audience

This user guide is intended for use by system administrators and technicians who are experienced
with the following:

e Direct Attached Storage (DAS), Storage Area Network (SAN), or Network Attached
Storage (NAS) operators

e Network administration
e Network installation
e Storage system installation and configuration

Prerequisites
Prerequisites for installing and configuring this product include familiarity with:

e Servers and computer networks
e RAID and input/output signal technology (such as SCSI, SATA, or NVMe)
e Fibre Channel and Ethernet protocols
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Document Conventions and Symbols

Table 1. Document Convention

Convention Element
Navy blue, underlined text Web site addresses
(http.//www.example.com)
Bold font Key names

Text typed into a GUI element, such as into a box

GUI elements that are clicked or selected, such as menu and
list items, buttons, and check boxes

Italics font Text emphasis
Monospace font File and directory names
System output
Code
Text typed at the command line
Monospace, Italic font Code variables
Command line variables
Monospace, bold font Emphasis of file and directory names, system output, code,

and text typed at the command line

Customer Support

For customer support, contact your system supplier or motherboard vendor.

Glossary
Table 2. Glossary of Terms
Term Definition
rcadm A command line interface (CLI) tool for managing RAID controllers on

Linux®, on Windows®, and UEFI operating systems. It is used for
creating, transforming, and deleting arrays; and adding and removing
disks.

disk Legacy disks include new or unrecognized disks which may contain data
or even an operating system. Legacy disks appear in the RAIDXpert2
Configuration Utility (HII) as legacy arrays. When the legacy disk is
initialized, configuration data is written to the disk. The legacy array
then becomes an online disk usable in arrays.

CAUTION: A legacy disk can contain valid data. When a legacy disk is
initialized, all data on the disk is lost.

Linux® Free, open-source UNIX-based operating system.
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Chapter 1 Getting Started

1.1 RAIDXpert2 Technology

RAIDXpert2 consists of (a) storage management and (b) a RAID controller and port virtualization.
RAIDXpert2 runs on existing systems by using a motherboard’s built-in SATA ports, PCle M.2
slots and PCle NVMe Add-in cards.

1.2 Who Should Use This User Guide

Only trained, experienced, and authorized personnel should install RAIDXpert2 and use its
features and capabilities.

All unit operators must be familiar with system hardware, data storage, RAID technology,
input/output signal technology (such as NVMe, SCSI, SAS, or SATA), and Direct Attached
Storage (DAS), Network Attached Storage (NAS), and/or Storage Area Network (SAN) concepts
and technology.

The intended user audience of this user guide is system administrators and experienced users.

1.3 System Requirements for Using RAIDXpert2

Make sure the systems that use RAIDXpert2 meet the requirements indicated in Table 3.

Table 3. System Requirements for RAIDXpert2

Component Requirements

Memory (RAM) Minimum: 2 at 8 GB, for a total of 16 GB for AMD Ryzen® processors
and AMD Ryzen® desktop processors.

Recommended: 4 at 8 GB for a total of 32 GB for AMD Ryzen® desktop
processors.

Storage Devices 1-14, ATAPI DVD, SATA, or SSD drives or M.2 SATA drives or NVMe
M.2 HHHL. The number of disks depends on the number, type, and
capacity of the arrays to be created.
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1.3.1 Supported Processors and Chipsets

The following processors are supported by the current release of RAIDXpert2:

Table 4. Supported Processors and Chipsets

Supported Processors &
Chipsets

Description

Supported AMD Processors | 3nd Gen AMD Ryzen™ Threadripper™ Processor
3rd Gen AMD Ryzen™ Desktop Processor

2nd Gen AMD Ryzen™ Threadripper™ Processor
2nd Gen AMD Ryzen™ Desktop Processor

AMD Ryzen™ Threadripper™ Processor

AMD Ryzen™ Desktop Processor

AMD Ryzen™ Desktop Processor with Radeon™ Vega Graphics

Supported AMD Chipsets AMD X570 Chipset
AMD X470 Chipset
AMD X399 Chipset
AMD B450 Chipset
AMD X370 Chipset
AMD B350 Chipset
AMD A320 Chipset

1.3.2 Supported Operating Systems

RAIDXpert2 supports the following operating systems:

RC-9.3.x Release:
e Microsoft® Windows® 10—64 bit.

New sTRX4 chipset supports the following:
e Ubuntu 20.04

e RHELS8.2

e Debian 10.3

Chapter 1 Getting Started
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1.4 Features of RAIDXpert2

The features of RAIDXpert2 described in this user manual apply to all supported operating

systems.

Table 5 describes these features. Also see Table 6, on page 20, for a summary of features that are
available with the RAIDXpert2 license.

Table 5. Features of RAIDXpert2

RAIDXpert2 Feature

Description

Arrays (general
information)

RAIDXpert2 allows:

e An array refers to data storage created by RAIDXpert2 from one or
more disks. Although an array can be created from several disks, it is
seen by the operating system as a single disk.

e Creating arrays of different RAID levels using the same disks.

e Creating different RAID level arrays on the same disk, to adapt each
array to the 1/0 that it processes.

e Creating an array from a mix of different type disks. For example, a
RAID10 array can be created from a group of disks that contain two
SATA 11 HDDs and two SATA SSDs or only on NVMe or group of
SATA and NVMe disks.

¢ Migrating an existing array to another RAID level, if the type of
array being used is not the optimal type for the application. This
function depends on the array capacity, redundancy level,
RAIDXpert2 license level and capacity of the drive or free space
available.

Array Hiding

An array can be hidden from the operating system so that neither the
software nor users can see or access it.

Array Recovery

If a redundant array is accidentally deleted, it might be recovered by
creating a new array with the same properties as the deleted array. (This
can occur only if disk Write Access operations are not in-progress.)

Background Array
Initialization (BGI)

The background initialization of a redundant array creates the redundant
data that allows the array to survive a disk failure.

Background initialization allows a redundant array to be used
immediately. Data is not lost if a disk goes offline prior to completion of
the BGI process.

Cache Support for Arrays

Various array-caching options are supported: No Cache, Read Ahead
Cache, Write Back Cache, Read Ahead and Write Back Cache.
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Table 5. Features of RAIDXpert2 (Continued)

RAIDXpert2 Feature

Description

Cache Support for Disks

Various disk-caching options are supported: No Cache, Read Ahead

Cache, Write Back Cache, Read Ahead and Write Back Cache.

Note: By default, NVMe Physical disk Read Ahead and Write Back
cache are always disabled. User cannot enable the setting as it
may impact the operational performance of the NVMe disk

Secure Erase

All data on an array can be erased and ensured it is unrecoverable, even
with advanced data recovery techniques.

Consistency Check

A Consistency Check is a background operation that verifies and
corrects the mirror or parity data for fault-tolerant disks. It is
recommended that a Consistency Check be run periodically on an array.

Disk Roaming

With disk roaming, SATA cables can be disconnected from their disks
and shuffled without confusing RAIDXpert2.

Note: Disconnect the SATA cables from the disks only when the system
is shutdown.

Disk roaming also allows:

o Disks to be moved to different slots in the backplane. RAIDXpert2
detects which disks belong to which arrays, regardless of where the
disks are moved in the backplane.

e Disk(s) to be moved between systems.

Note: It might not be possible to move disks between systems if they

contain boot arrays.

Fault Tolerance

The following fault tolerance features are available with RAIDXpert2,
in order to prevent data loss in case of a failed disk.

e Disk failure detection (automatic).

e Array rebuild using hot spares (automatic, if the hot spare is
configured for this functionality).

e Hot-swap manual replacement of a disk without rebooting the
system (available only for systems with a backplane that supports
hot-swapping) is not recommend for disks that are part of the Boot
Virtual Disk or are connected to the AMD RAID supported
chipsets. This applies to all chipsets.

For example, if a disk fails in a RAID1, the array remains functional
and data is read from the surviving mirrored disk.

Mirror Rebuilding

A broken mirrored array can be rebuilt after a new disk is inserted and
the disk is designated as a spare. The system does not have to be
rebooted.

Multiple RAID Levels per
Disk

Support for multiple array levels per disk allows the administrator to
create arrays of different RAID levels using the same disks.
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Table 5. Features of RAIDXpert2 (Continued)

RAIDXpert2 Feature

Description

Native Command Queuing

(NCQ)

Native Command Queuing is a command protocol of disks that are
supported by RAIDXpert2. NCQ enables individual disks to internally
optimize the order in which Read and Write commands are executed.
RAIDXpert2 permits a queue depth of up to 32 read/write commands
per disk.

Online Capacity Expansion
(OCE)

OCE is a process that allows the user to add storage capacity to an
existing array, without taking the system offline. OCE enables the user
to increase the total storage capacity of an array by integrating unused
storage into the array.

Data can be accessed while the disks are added and while data on the
array is being redistributed.

Online RAID Level
Migration (ORLM)

With online RAID level migration, users can easily move an array from
one RAID level to another. While the migration is taking place, data is
accessible and protected to the lowest protection of either the source
RAID level or the destination RAID level.

RAID Level Support

RAIDXpert2 supports RAID levels 0, 1, 5, 10, Volume, and
RAIDABLE.

Note: RAIDS5 is only supported for AMD Family 17h Models 31h
STRX4 processors.

Self-Monitoring Analysis
and Reporting Technology
(SMART)

SMART is a hard-disk-drive (HDD) capability which allows reporting
of reliability information. If a drive anticipates there is a high likelihood
of future failure it triggers a SMART error condition. RAIDXpert2
presents this error condition so the drive can be replaced before the
predicted failure occurs.

1.5

RAIDXpert2 Feature Set

Table 6. Supported Feature Set for RAIDXpert2

Features

Sub-Features

UEFI Driver (BIOS) Support

Create array

Delete array

Raidxpert2 Configuration utility (HII)

efi Shell utility
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Table 6. Supported Feature Set for RAIDXpert2 (Continued)

Features

Sub-Features

RAID Levels Supported?

10

RAIDable

5

Note: RAIDS is only supported for AMD Family 17h Models 31h
STRX4 processors.

Volume

Array Creation

No initialization

Foreground initialization

Background array scan

No reboot required

Multiple RAID levels per disk?

Array Deletion

No reboot required

Array Transformation

Online RAID Level Migration (ORLM)

Sparing

Global

Dedicated

Consistency Check

Background redundancy check

Online Capacity Expansion (OCE)?

Online RAID Level Migration (ORLM)
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Table 6. Supported Feature Set for RAIDXpert2 (Continued)

Features

Sub-Features

Drive/Disk Roaming*

Same-system support

Between-systems support

Non AMD-RAID system (AHCI) NOT supported

RAIDXpert2 GUI (Management GUI)

UWP based interface for Array and Disk Management

rcadm (management CLI)

Drive Interfaces Supported®

SATA

SSD

ATAPI

M.2 SATA SSD

M.2 NVMe SSD

HHHL NVMe SSD

Dissimilar Disk Support Within the Same
Array

Cache Support

No Cache

Read Ahead Cache

Write Back Cache

Read Ahead and Write Back Cache

Restore (Rebuild) Priority

Touched Region Logging

System Event Log Integration

Instant Create Support®

Hot-Swap Support’
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Table 6. Supported Feature Set for RAIDXpert2 (Continued)

Features Sub-Features

NVMe Swap Support®

Notes:

See Chapter 2, Understanding Arrays, Disks and RAID Levels, on page 24, for detailed
information about understanding arrays, RAID levels, and performance and reliability
considerations.

Multiple RAID levels (array types) per disk allows the administrator to create different RAID levels
on the same disks. For example: The administrator wants data redundancy for the user data and
creates a RAID1 set using part of the disks’ data. At the same time the administrator wants
performance for the swap spaces and creates a RAIDO array using the rest of the disks’ capacities
(space). This feature is useful in collecting unused capacity from disks with different capacities.
This feature increases data integrity for redundant array types, by logging areas of an array that
have been written to. In the event of a system crash, the logged area’s consistency is checked
and/or corrected. Without this feature, data corruption might occur.

The unique ability of RAIDXpert2 to provide online expansion to RAID levels across multiple disks
becomes extremely valuable when expanded storage is a requirement.

Disk roaming allows arrays to be moved from port to port, either within the same system or
between systems.

See the system’s motherboard specifications for the supported device interface. RC-8.1 and RC-
8.2 branches support only SATA. RC-9.1 and above release branches support SATA, M.2 NVMe
SSD and HHHL NVMe SSD

Arrays can be instantly created and used by skipping the background consistency check. For
certain types of redundant arrays this is a viable option and has no data integrity drawbacks. A
consistency check can always be done later. If an initialization is skipped when creating a RAID]T,
the array is not redundant until a consistency check is performed.

It is not recommended to add a Disk to the system and to the array while the system is
operating.
If a user wants to add or remove a NVMe into a system, it is AMD’s recommendation that a reset

of the system is performed, wait for the BIOS screen to appear, then power off the system and
add or remove the NVMe(s).

Chapter 1
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Chapter 2 Understanding Arrays, Disks and

RAID Levels

2.1 Understanding Arrays

Arrays are several disks that are grouped together to improve either the performance or reliability

of a storage system. Because some RAID levels enhance performance while others improve
reliability, it is important to consider the user’s needs when planning an array configuration.

Note: It is highly recommended that this user manual be reviewed in its entirety before

configuring arrays. Some of the advanced features of RAIDXpert2 (such as sparing options)
must be understood by the user before creating arrays.

2.2 RAID Levels

RAIDXpert2 supports the RAID levels indicated in Table 7.

Table 7. RAID Levels — General Characteristics

RAID Level Main Characteristic

Use/Usefulness

RAIDO (Striping) | e Provides the highest performance | e
but no data redundancy. Data in
the array is striped (distributed)
across several disks.

e Supports 2-8 disks.

RAIDO arrays are useful for
holding information, such as the
operating system paging file,
where performance is extremely
important, but redundancy is not.

RAID1 e Mirrors data on a partition of one | e
(Mirroring) disk to another.

e Supports 2 disks.

Useful when there are only two
disks available and data integrity
is more important than storage

capacity.

RAID10 (Striped |e Combines mirrors and stripe sets. | e
RAID1 Sets) RAID10 allows multiple disk

failures, up to 1 failure in each
mirror that has been striped. o

e Supports 4, 6, or 8 disks.

Offers better performance than a
simple mirror because of the extra
disks.

Requires twice the disk space of
RAIDL1 to offer redundancy.
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Table 7. RAID Levels — General Characteristics (Continued)

RAID Level

Main Characteristic

Use/Usefulness

RAID5

RAIDS is only supported for
AMD Family 17h Models 31h
STRX4 processors..

Stripes data as well as parity,
across all disks in the array.

In the event of a failure,
RAIDXpert2 can restore the lost
data of the failed disk from the
other surviving disks.

Supports 3-8 disks.

o Offers exceptional read
performance and redundancy.

e Write performance is not an issue
due to the tendency of the
operating system to perform many
more reads than writes.

e Requires only one extra disk to
offer redundancy.

e For most systems with three or
more disks this is the correct
choice for a RAID level.

Volume (JBOD)

RAIDXpert2 treats one or more
disks or the unused space on a
disk as a single array.

Supports 1 to 8 disks

Provides the ability to link-together
storage from one or several disks,
regardless of the size of the space on
those disks.

Useful in scavenging space on disks
unused by other disks in the array.
Does not provide performance benefits
or data redundancy. Disk failure will
result in data loss.

RAIDABLE (also
known as RAID
Ready)

Allows a RAIDABLE disk to be
transformed later to RAIDO or
RAIDL1.

Supports one disk.

See RAIDO (Striping), on page 24 or
RAID1 (Mirroring) on page 24 for
post-transformation usefulness.

2.3 Array States

Within the management applications, an array is a logical device that can exist in one of four
states: Normal, Ready, Critical, or Offline.

e In RAIDXpert2, these states display in the Array List section in a column named State.
e Within the rcadm Command Line interface, these states also display in a column named

State.

The array states are defined in Table 8, on page 26.
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Table 8. Array States

State Description
Normal The Normal state is displayed when everything is functioning correctly.
Ready The Ready state is displayed while an array is being created.
Critical The Critical state is displayed when the array is no longer redundant (fault

tolerant) because of one or more disk failures. Arrays can still be read and written
to, but the data is no longer protected should another disk fail.

Offline The Offline state is displayed when arrays cannot be read or written to because of
one or more disk failures.

Whether an array is marked as Critical or Offline depends upon what RAID level it is and how
many disks within the array have failed. Note the changes in state in Table 9.

Table 9. Device Failure by RAID Level

RAID Level Failure State Is Displayed Whenever
RAID1 Critical A single disk fails.
(Redundant Arrays)
Offline Two disks fail.
RAID10 Critical A single disk fails in any one of the
(RAID Levels with Multiple sets.
Redundancies)
Offline All the disks in a set fail.
Volume, RAIDABLE and Offline A single disk fails.
RAIDO
RAIDS Critical A single disk fails.
(Redundant Array)
Note: RAID5 is only supported for | Offline Two disks fail.

AMD Family 17h Models 31h
STRX4 processors.

More than one array can be created using the same set of disks. If a disk is disconnected that
belongs to more than one array, only the arrays that try to access the disk and receive 1/O errors
report the failure. For example: there are two arrays, both of which are RAID1 sets and both use
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disk 4. If a system that is being used by array 1 receives an 1/O error when trying to communicate
with disk 4, the state of array 1 changes to Critical. However, the state of array 2 using disk 4 does
not change to Critical until an 1/0 error is reported. If systems using array 1 are not
communicating with failed disk 4, the state of array 1 still displays as Normal.

If a rescan of all channels is performed after disconnecting a disk, the state of every array using
the missing disk changes from Normal to either the Critical or Offline, depending on the RAID
level.

See Section 2.9, Rescanning Disks for Changes in State, on page 31 for a discussion of when to
rescan disks and the outcomes when doing so.

2.4 Creating Arrays: Future Expansion

When creating arrays, consider whether disk capacity needs to expand in the future. If the file
system must be expanded, perform the tasks indicated in Table 8

Table 10. Array Expansion Considerations

Operating System Do This... And Consider This...
Microsoft® Windows® Format the arrays with 1. The Diskpart.exe utility version
NTFS. Microsoft depends on which version of the
Corporation provides a Windows operating system is

utility (Diskpart.exe) that can | running.

dynamically extend an NTFS | 2. The Diskpart.exe utility can be
file system onto any unused | found on the CD for some versions

adjacent space. of Windows operating systems, or on
Note also that using a single | the Microsoft Corporation website
partition per array makes (http://www.microsoft.com)
expansion much easier. for other versions. Use the correct

version for the operating system.

Linux® Use an expandable file Because RAIDXpert2 software is
system. limited to eight arrays, if a large
number of logical volumes are
needed, use a logical volume
manager (LVM).

2.5 Expanding Disk Capacity Online: Using OCE
Online Capacity Expansion (OCE) allows:

e Adding disks to an array at any time to increase an array’s capacity.
e Accessing the array data while it is being redistributed.
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To increase the size and organization of an array, transform the array. For more information about
transforming arrays, see Section 6.4.3, Transform Arrays on page 88.

2.6 Migrating RAID Levels Online: Using ORLM

Online RAID Level Migration (ORLM) allows an array to move from one RAID level to almost
any other RAID level. This task includes migrating the array from a non-redundant RAID level to
a redundant RAID level.

Prior to starting a RAID level migration/transformation, make sure that the disks selected for the
destination array have sufficient capacity. RAID level migration/transformation can occur only
when the destination array has the same or larger capacity as the source array.

While the migration/transformation is taking place, data is accessible and protected to the lowest
protection of either the source RAID level or the destination RAID level.

The Transform task can also be used to expand the capacity of an array, by using OCE. It can also
be used as part of the system backup and recovery strategy using the RAID1 and RAID10 levels.

To perform this process, see Section 6.4.3, Transform Arrays on page 88.

2.7 Array Tasks: Starting and Stopping Tasks
Tasks are started when one of the following actions are performed:

e Create a redundant array.

e Transform an array.

e Restore an array.

e Securely erase an array.

e Check for consistency on redundant arrays.

e Verify that data was not corrupted after a system crash (Check Bitmap performed
automatically).

Full task control can be used on Create, Consistency Check, and Bitmap Check tasks. On a
Transform or Restore task for dedicated and global spares, task control can only pause/resume, but
it cannot remove the task. To remove these types of tasks, pause and then remove them.

The tasks indicated in Table 11 on page 29, can be displayed for each array.
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Table 11. Types of Tasks per Array

Task When Displayed

Transform While an array is being transformed.

Create While an array is being created.

Consistency While verifying the mirror disk (RAID1 or RAID10) consistency is correct.

Check (For redundant type arrays only.)

Restore While an array is being restored.

Secure Erase While an array secure erase is being performed.

Check_Bitmap While verifying that the mirror halves on a RAID1 or RAID10 set, are
consistent. This action is performed automatically to ensure that data is not
corrupted whenever a system crashes.

Not_Active When no other tasks are being performed.

2.8 Understanding Disks

2.8.1 Disks States

Within the management applications, a disk can be part of one or more arrays and can exist in one
of five states: Online, Offline, New, Legacy, or SMART Error.

e In RAIDXpert2, these states are displayed in the Disk List section in a column named
State. See Table 18, on page 80, for additional information.

e Within the rcadm command line interface, these states are also displayed in a column
named State. See Table 30, on page 104, and Table 31, on page 105, for additional
information.

The disk states are defined in Table 12.

Table 12. Disk States

Disk State When Displayed

Online Whenever the disk is connected, functioning correctly, and RAIDXpert2 can
communicate with it.
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Table 12. Disk States (Continued)

Disk State When Displayed
New Whenever an uninitialized, new disk is connected.
Legacy Whenever a disk containing non-RAIDXpert2 configuration data is connected.
Offline Whenever the disk fails and RAIDXpert2 detects an error condition on the disk.
SMART Error Whenever the disk reports a SMART error(s) to RAIDXpert2.

A disk can be a member of multiple arrays. A disk failure in one array doesn't necessarily mean it
has failed in other arrays.

After a rescan is performed the following can occur:

e A disconnected disk no longer appears in the Disk List (although the disk appears as
Missing in the Array View for the arrays to which it belonged).

e A disk that experiences a catastrophic failure appears in the Disk List as Offline and is
highlighted in red. The disk appears as Failed for the arrays to which it belonged.

e Adisk that has a SMART error appears in the Disk List as SMART Error. (A disk with a
SMART error can’t be used to create an array)

e A disk that experiences a software-related failure appears in the Disk List as Online and is
highlighted in red. New arrays can be created with the disk.

Arrays that exist on a failed or disconnected disk might not be designated as Failed or Missing
until the system attempts to communicate with the failed or disconnected disk.

2.8.2 Disks
A legacy disk is a disk that contains valid data from a Non AMD-RAID controller.

A legacy disk appears in RAIDXpert2 GUI and RAIDXpert2 Configuration Utility (HII) with a
corresponding legacy array. When the legacy disk is initialized in RAIDXpert2 GUI and
RAIDXpert2 Configuration Utility (HII) the legacy array disappears.

CAUTION: A legacy disk can contain valid data. When a legacy array is deleted the data is lost.
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28.2.1 Legacy Disk and New Disk

Table 13 provides information on how disks appear in RAIDXpert2 GUI and RAID Xpert2
Configuration Utility (HII).

Table 13. New and Legacy Disks, as They Appear in the RAIDXpert2 Configuration Utility
(HII) and RAIDXpert2

Status of the Disk RAIDXpert2 Utility In the BIOS Configuration
Utility/RAIDXpert2
Configuration Utility (HII)

New, un-initialized disk. The disk appears as a new disk | The disk appears as a new disk
with a legacy array. (the disk can appear with a
When the new disk is legacy array).
initialized, its state changesto | When the new disk is
Online (or similar). initialized, RAIDXpert2

configuration data is written to
the disk. The disk state changes

to Online.
A disk containing non- The disk appears as a legacy The disk appears as a legacy
RAIDXpert2 configuration disk with a legacy array. disk with a legacy array.
data. When the legacy array is When the legacy array is
CAUTION: A legacy disk can | deleted, the legacy array deleted the state of the legacy
contain valid data. When a disappears and the legacy disk | disk changes to Empty. The
legacy array is deleted, or type changes to Disk. The disk | disk can now be used in
when its corresponding legacy | can now be used in RAIDXpert2 arrays.
disk is initialized, the data is RAIDXpert2 arrays.
lost.

Note: A Native AHCI installation will not boot into the OS, after changing the BIOS settings to
RAID mode.

See Chapter 6, AMD RAIDXpert2 Graphical User Interface (GUI), on page 77, for the disk
initialization procedure and the appearance of legacy disks in the BIOS Configuration Utility.

2.9 Rescanning Disks for Changes in State

The information displayed in the Disk List section is the state of the disks when they were last
scanned. If a rescan has not been performed, the information being displayed is the state of the
disks at boot time.

Every time a disk is connected or disconnected while online, a message asks if the user wants to
perform a rescan (of all SATA channels). If Rescan is selected, the information in both the Array
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List and the Disk List is updated. This view might show arrays as being in a Critical or Offline
state if all disks have not been installed or removed.

Although it is highly recommended that the system be shut down before adding or removing disks,
disks can be added or removed while the system is online (“hot-swapping”), if the system supports
the hot-swapping function. This is not recommended for disks that are part of the Boot Virtual
Disk or those that are connected to the AMD RAID supported chipsets.

Because of this function, RAIDXpert2 does not automatically perform a rescan when it detects
that a disk has been added or removed. For example, to hot-swap a RAID1 set with two disks into
a new system, do not perform a rescan until both disks have been connected.

Arrays associated with the disks that are not yet connected change state to either Critical or
Offline. In the example above, if the state of the RAID1 set changes to Offline, data is unavailable.

Rescanning can also result in the state of a disk being reported differently in the Array View and
the Disk List. A disk within an array can have a state of Failed in the Array View field, while at
the same time it can show a state of Online in the Disk List.

2.10  Sparing Options: Disks and Arrays

RAIDXpert2 supports multiple sparing options. Spares are restored in the order indicated in Table
14.

Table 14. Sparing Options

Option Description
Dedicated A spare disk assigned to a specific redundant array.
Global A spare disk that is shared by multiple arrays.

Note: An array is marked Critical or Offline if a disk reports a Failed state to an 1/O, or if the
Disk, SATA cable, or power cable is disconnected.

Note: One or more spares can be assigned to a redundant RAID level.

Note: Spare assignments do not apply to non-redundant RAID levels. To protect data, transform
the array to a redundant RAID level. Spares can then be assigned.

2.11  Dedicated Sparing

A dedicated spare is a disk that is assigned as an alternate disk for a specific array. Should a disk
fail in that array, the alternate disk is used to replace the failed disk and the array is rebuilt.
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A dedicated spare can be assigned to any redundant array type, and up to four spares can be
assigned to an array.

Note: Disk capacity of the Dedicated Spare must be greater or equal to the capacity of the
smallest disk in the array.

CAUTION: Assigning a dedicated spare does not reserve space on the disk. Therefore, an
automatic restore is not guaranteed if a disk fails. If a disk fails, make space on the
disk for the fail-over to complete, or assign a different disk with enough space. If a
dedicated spare is assigned and a disk fails, the restore process starts automatically,
if there is enough space available on the dedicated spare.

For additional information, see Section 6.4.12, Add or Remove Dedicated Spares, on page 97.

2.12  Global Sparing

A global spare is a disk that is assigned as an alternate disk for multiple arrays, instead of
associating it with only one array.

Many arrays can be restored using the global spare disk, if it is not already part of the array and it
has enough space available. Unlike a dedicated spare, this type of spare can be assigned at any
time, even while tasks are running on arrays.

Assigning a disk for use as a global spare does not reserve space on that disk. An automatic restore
is not guaranteed if a disk fails.

If there is not enough disk space on the global spare, make room for the fail-over to complete, or
assign a different disk with enough capacity as the spare. If there is enough space available on the
global spare and a disk failure occurs, the restore process starts automatically.

For additional information, see Section 6.4.13, Add or Remove Global Spares, on page 97.

2.13  RAID Performance Considerations
With RAID technology, performance is based on the following considerations:

e The number and organization of disks in an array.
e Caching attributes used for the array.
e Application workload.

o Array level verify that the array creation has completed before running any performance
testing.
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2.13.1 Number and Organization of Disks

RAID functions increase performance by putting more disks to work and by buffering data for the
host.

Many disks can transfer data at greater than 100 MB per second. RAIDXpert2 can aggregate this
bandwidth in an almost linear fashion, as more of the same disks are included in an array.

2.13.2 Caching Attributes

Arrays can also be configured to provide Read and Write Back cache, Write Back cache, Read
Ahead cache, and No cache option with RAIDXpert2 configuration utility and WebGUI utility, if
desired. Write Back caching has a large effect on most workloads but should be used with caution.

2.13.3 Application Workload
When configuring an array, workload is probably the most important performance variable. Most

applications do many more reads than writes. The best performance is obtained with array types
like RAIDO or RAID10.

2.14  RAID Reliability Considerations

RAID reliability is enhanced through data redundancy and backup.

2.14.1 Data Redundancy

RAID1, RAID5, or RAID10 are necessary for redundancy. With redundancy, both capacity and
performance are sacrificed for reliability. With RAIDXpert2, extremely high performance is
obtained even with redundant-type arrays.

Note: RAIDS is only supported for AMD Family 17h Models 31h sTRX4 processors.

2.14.2 Backup

It is good practice to back up your data periodically in case of a catastrophic failure. Tape backup
or other media can be used to secure your data.

2.15  Flexibility and Expansion Considerations

Before configuring an array, consider the following points to enhance the flexibility of the RAID
system.

34 Understanding Arrays, Disks and RAID Levels Chapter 2



AMDA

53987 Rev. 3.11 June 2020 AMD-RAIDXpert2 User Guide

2.16  Multiple RAID Levels

With RAIDXpert2, different RAID levels can be created on the same disk, to adapt each array to
the 1/0 that it processes. Also, more than one array can be created per disk.

Depending on the array capacity and redundancy level, an existing array can be transformed to
another RAID level, if the level of the array being used is not the optimal RAID level for the
application. Also, different arrays with different characteristics can be built for different
applications.
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Chapter 3 Platform BIOS RAID
Configuration Prerequisites

This chapter assists to configure and enable RAID mode in Platform BIOS for the listed AMD
products in Table 4 on page 17.

Note: Prior to starting the below procedure, Platform should be programmed with RAID
Supported BIOS. Obtain the BIOS from your system supplier or motherboard vendor.

3.1 Enable RAID for the x570/590 AMD Socket AMA4-
Compatible Processors

Note: The steps to configure a system to RAID mentioned here are specific to AMD NDA BIOS
based off the AMI BIOS. The steps for other BIOS Vendors will be different.

1. Power-ON the system.
2. Press ESC to enter the System BIOS setup page.
3. Inthe BIOS setup:

a. Select CSM Configuration, then press Enter.

b. Set CSM Support to Enabled, then press Enter.

c. Set Boot option filter to UEFI only, then press Enter.

d. Set Storage to UEFI, then press Enter.
4. Inthe BIOS setup:

a. Select the Advanced tab.

b. Select FCH Common Options, then press Enter.

c. Select SATA Configuration Options, then press Enter.

d. Set SATA Enable to Enabled, then press Enter.

e. Set SATA Mode to RAID, then press Enter.
5. Inthe BIOS setup:
Select the Advanced tab.
Select X570/590 Chipset Common Options, then press Enter.
Select X570/590 Chipset SATA Configuration Options, then press Enter.
Set X570/590 Chipset SATAO Enable to Enabled, then press Enter.
Set X570/590 Chipset SATAL Enable to Enabled, then press Enter.
Set X570/590 Chipset SATA Mode to RAID, then press Enter.
6. Inthe BIOS setup:

-~ ® 00 T @
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7.

3.2

Note

\]

3.3

Note

1.

a. Select the Advanced tab.
b. Set NVMe RAID Mode to Enabled, then press Enter.
Save (F4) the settings and restart the system.

Enable RAID for the 300/400/500 AMD Socket AM4-
Compatible Processors

: The steps to configure a system to RAID mentioned here are specific to AMD NDA BIOS

based off the AMI BIOS. The steps for other BIOS Vendors will be different.

Power-ON the system.
Press ESC to enter the System BIOS setup page.
In the BIOS setup:
a. Select CSM Configuration, then press Enter.
b. Set CSM Support to Enabled, then press Enter.
c. Set Boot option filter to UEFI only, then press Enter.
d. Set Storage to UEFI, then press Enter.
In the BIOS setup:
Select the AMD-CBS.
Select FCH Common Options, then press Enter.
Select SATA Configuration Options, then press Enter.
Set SATA Enable to Enabled, then press Enter.
Set SATA Mode to RAID, then press Enter.
In the BIOS setup:
a. Select the AMD-CBS.
b. Select 300/400/500 Chipset Common Options, then press Enter.
c. Select 300/400/500 Chipset SATA Configuration Options, then press Enter.
d. Set PT SATA Mode to RAID, then press Enter.
In the BIOS setup:
a. Select the AMD-PBS tab.
b. Set NVMe RAID Mode to Enabled, then press Enter.

® oo o

. Save (F4) the settings and restart the system.

Enable RAID for the AMD SP3-Series Chipsets

: The steps to configure a system to RAID mentioned here are specific to AMD NDA BIOS

based off the AMI BIOS. The steps for other BIOS Vendors will be different.
Power-ON the system.
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2. Press Delete or ESC to enter the System BIOS setup page.
3. Inthe BIOS setup:
a. Select the Advanced tab, then press Enter.
b. Select the AMD PBS tab, then press Enter.
c. Set NVMe RAID Mode to Enabled.
4. Inthe BIOS setup:
a. Select the Advanced tab, then press Enter.
b. Select the AMD CBS tab, then press Enter.
c. Select FCH Common Options, then press Enter.
d. Select SATA Configuration Options, then press Enter.
e. Set SATA Controller to Enabled.
5. Inthe BIOS setup:
a. Select the Advanced tab, then press Enter.
b. Select the AMD CBS tab, then press Enter.
c. Select FCH Common Options, then press Enter.
d. Select SATA Configuration Options, then press Enter.
e. Set SATA Mode to RAID.
6. Inthe BIOS setup:
a. Select the Advanced tab, then press Enter.
b. Select Promontory Common Options, then press Enter.
c. Select PT SATA Configuration Options, then press Enter.
d. Set PT SATA Port Enable to Enabled.
7. Inthe BIOS setup:
a. Select the Advanced tab, then press Enter.
b. Select Promontory Common Options, then press Enter.
c. Select PT SATA Configuration Options, then press Enter.
d. Set PT SATA Mode to RAID.
8. In the BIOS setup:
a. Select the Advanced tab, then press Enter.
b. Select CSM Configuration, then press Enter.
c. Set CSM Support to Enabled.
9. Inthe BIOS setup:
a. Select the Advanced tab, then press Enter.
b. Select CSM Configuration, then press Enter.
c. Set Boot Option Filter to UEFI Only.
10. In the BIOS setup:
a. Select the Advanced tab, then press Enter.
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b. Select CSM Configuration, then press Enter.
c. Set Storage > UEFI.
11. Save (F4) the setting and restart the system.
12. To proceed with RAID array creation, refer to Create Arrays.

3.4 Enable RAID for the AMD Socket AM4-Compatible
Processors

Note: The steps to configure a system to RAID mentioned here are specific to AMD NDA BIOS
based off the Insyde BIOS. The steps for other BIOS Vendors will be different.

Power-ON the system.
Press ESC to enter the System BIOS setup page.
Select Setup Utility, then press Enter.
In the BIOS setup:
a. Select the Advanced tab.
b. Select IDE Configuration, then press Enter.
c. Set SATA Configure As to RAID, then press Enter.
d. Set Force RAID Mode to Enabled, then press Enter.
5. Inthe BIOS setup:
a. Select the Boot tab.
b. Set Boot Type to Dual or UEFI Boot Type, then press Enter.
c. Set EFI Device First to Enable, then press Enter.
6. Inthe BIOS setup:
a. Select the AMD-PBS tab.
b. Set NVMe RAID Mode to Enabled, then press Enter.
7. Inthe BIOS setup:
a. Select the AMD-CBS tab.
b. Select SATA Configuration Options, then press Enter.
c. Set SATA Controller to Enabled, then press Enter.
d. Set SATA Mode to RAID, then press Enter.
8. Inthe BIOS setup:
Select the AMD-CBS tab.
Select Promontory Common Options, then press Enter.
Select PT SATA Configuration Options, then press Enter.
Set PT SATA Port Enable to Enabled, then press Enter.
Set PT SATA Mode to RAID, then press Enter.
9. Save (F10) the settings, then restart the system.

M owbdhe
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Before you begin, enable platform RAID mode by referring to Chapter 3, Platform BIOS RAID

Configuration Prerequisites, on page 36.

3.5
(HI)

When to Use the RAIDXpert2 Configuration Utility

The RAIDXpert2 Configuration Utility is also known as the HII. Use the utility to accomplish the

procedures indicated in Table 15.

Table 15. When to use the AMD-RAID RAIDXpert2 Configuration Utility (HII)

Procedure

Description

Find Information At

Initialize a new
disk

To initialize a new disk drive for
data storage.

Section 3.7, Initialize Disks, on page 41

Create Arrays

Create arrays at different RAID
levels (depending on the license
level for the system)

Section 3.8, Create Arrays, on page 42
Section 0, , on page 47

Delete Arrays

Delete an array

Section 0, , on page 47

Manage hot
spares

Allows selection of global and
dedicated hot spares.

Section 3.10, Manage Spares, on page 47

View Controller
details

View information about each
controller.

Section 3.11, View Controller Details, on page
48

Section 3.12, View Disk Details, on page 49

View Disk details

View information about each disk.

Section 3.11, View Controller Details, on page
48

View Array View information about each array. | Section 3.12, View Disk Details, on page 49
details
Rescan all Rescan all channels to detect new | Section 3.14, Rescan All Channels, on page
channels or removed disks and arrays. 50
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3.6 Access the AMD RAIDXpert2 Configuration Utility
(HI)

AMD SP3-Series Chipsets BIOS is based on AMI BIOS. To enter the RAIDXpert2 Configuration
Utility (HII complete the following.

Note: The following step(s) is specific to AMD NDA BIOS.

1. Power ON the system.

2. Press DEL.

3. Inthe Menu Bar, select Advanced.

4. Select RAIDXpert2 Configuration Utility, then press Enter.

AMD Socket AM4-Compatible Processor is based on Insyde BIOS. To enter the RAIDXpert2
Configuration Utility (HII) complete the following:

1. Power ON the system.

2. Press ESC.

3. Select Device Management, then press Enter.

4. Select RAIDXpert2 Configuration Utility, then press Enter.

Note: If the BIOS Configuration Utility does not display, contact your system or motherboard
supplier.

3.7 Initialize Disks

New disks and legacy disks must be initialized before they can be used to create an AMD-RAID
array.

Initialization writes AMD-RAID configuration information (metadata) to a disk.

CAUTION: If a disk is part of an AMD-RAID array, the disk cannot be selected for initialization.
To initialize the disk anyway, delete the AMD-RAID array. Data on the disk is deleted
during initialization so ensure the correct disks are chosen to initialize.

CAUTION: A legacy disk can contain valid data. When a legacy array is deleted, all data on the
disk is lost.

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Physical Disk Management, then press Enter.

2. Select Select Physical Disk Operations using the arrow keys, then press Enter.

3. Highlight Initialize Disk using the arrow keys, then press Enter

4. Select the disk(s) to initialize:

e To select individual disks, highlight a disk with the arrow keys and press the space
bar or Enter. Multiple disks may be selected using this method.
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e When the desired number are selected, use the arrow keys to select OK, then press
Enter.

e Review the warning message, if you want to proceed, use the arrow keys to select
YES, then press the Enter key, or press ESC to cancel the initialization.

Initialization takes 10 to 15 seconds per disk. During initialization, a complete rescan of all
channels is done automatically.

3.8 Create Arrays

Arrays can be created after the disks are initialized. See Section 2.2, RAID Levels, on page 24, for
deciding what type of RAID levels to use for the array.

TIP: See also Section 6.4.1, Create and Format Arrays on page 85, and Section 7.4, Create New
Arrays: rcadm --create, on page 106.

3.8.1 Before You Begin

e In some circumstances, more than eight arrays are possible. They might appear to function
properly but are not supported by AMD-RAIDXpert2.

e For redundant arrays the Create process starts after the operating system and AMD-RAID
OS drivers are installed and the system is booted to the operating system. However, the
arrays are immediately available to use for either a bootable array or a data array.

e Array numbers are valid only for a given boot and might be different in the RAIDXpert2
Configuration Utility (HII) and RAIDXpert2 GUI. If a permanent label is required, use the
RAIDXpert2 GUI Array Naming feature.

e Atany point in the procedure return to a prior window by pressing ESC.

e If the system is booted from an AMD-RAID bootable array the first array in the Arrays
section must be the bootable array. The system boots only from the first array in the
Arrays section.

3.8.2 Create an Array

Before proceeding with array create and manage, System BIOS configuration should be setup as
mentioned in Chapter 3, Platform BIOS RAID Configuration Prerequisites for system RAID mode
to be enabled.

Note: The following step(s) are specific to AMD NDA BIOS. AMD SP3-Series Chipsets BIOS is
based on AMI BIOS. AMD Socket AM4-Compatible Processor is based on Insyde BIOS.

The RAIDXpert2 Configuration Utility can be used to create a bootable array with levels
Volume, Raidable, RAIDO, RAID1, RAID5 and RAID10. Configure array cache and Cache
tag size settings by following the steps mentioned in the following sections.
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Table 16. Default Cache Tag Size

Array Type Default CTS
HDD Array 64 K
SSD Array
Mix of HDD/SSD Array
All NVMe Array 256 K
Mix of NVMe with HDD/SSD Array 256 K

Caution: Cache Tag Size for an array cannot be changed after creation.

To install the operating system and RAIDXpert2 files see Chapter 4, Software Installation, on
page 51.

3.8.2.1

Create an AMD-RAID Bootable Array

To install the operating system, AMD RAID Device driver and RAIDXpert2 GUI utility refer to
Chapter 4, Software Installation, on page 51.

CAUTION: Do not use eSATA drives for bootable arrays as they are removable.

3.8.2.2

Note

1.

Create a RAIDABLE Array

: Refer to Table 7 for RAIDABLE array characteristics.

From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.

Select Create Array using the arrow keys, then press Enter.
Select Select RAID Level using the arrow keys, then press Enter.

From the Select RAID Level Drop down menu, use the arrow keys to select RAIDABLE,
then press Enter.

Select the disk with which to create the array:
Select Physical Disks using the arrow keys, then press Enter.

Select an individual disk, highlight a disk using the arrow keys and press the space bar or
Enter.

e Select Apply Changes using the arrow keys, then press Enter.
Note: Refer to Table 16 on page 43 for Default Cache Tag Size.

Select Read Cache Policy using the arrow keys, then press Enter.
e Select the desired Read Cache Policy, then press Enter.

Select Write Cache Policy using the arrow keys, then press Enter.
e Select the desired Write Cache Policy, then press Enter.
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10. Select Create Array using the arrow keys, then press Enter.

3.8.2.3 Create a VOLUME Array
Note: Refer to Table 7 for VOLUME array characteristics

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.

2. Select Create Array using the arrow keys, then press Enter.
3. Select Select RAID Level using the arrow keys, then press Enter.

e From the Select RAID Level drop-down menu, use the arrow keys to select
VOLUME, then press Enter.

4. Select the disks with which to create the array:
e Select Physical Disks using the arrow keys, then press Enter.

e Select desired disks, highlight a disk with the arrow keys and press the space bar
or Enter.

e Select Apply Changes using the arrow keys, then press Enter.
Note: Refer to Table 16 on page 43 for Default Cache Tag Size.

5. Select Read Cache Policy using the arrow keys, then press Enter.
e Select the desired Read Cache Policy, then press Enter.

6. Select Write Cache Policy using the arrow keys, then press Enter.
e Select the desired Write Cache Policy, then press Enter.

7. Select Create Array using the arrow keys, then press Enter.

3.8.24 Create a RAIDO Array
Note: Refer to Table 7 for RAIDO array characteristics

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.

2. Select Create Array using the arrow keys, then press Enter.
3. Select Select RAID Level using the arrow keys, then press Enter.

e From the Select RAID Level drop-down menu, use the arrow keys to select
RAIDO, then press Enter.

4. Select the disks to create the array:
e Select Physical Disks using the arrow keys, then press Enter.

e Select desired disks, highlight a disk with the arrow keys and press the space bar
or Enter.

e Select Apply Changes using the arrow keys, then press Enter.
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Note: Refer to Table 16 on page 43 for Default Cache Tag Size.

5. Select Read Cache Policy using the arrow keys, then press Enter.
e Select the desired Read Cache Policy, then press Enter.

6. Select Write Cache Policy using the arrow keys, then press Enter.
e Select the desired Write Cache Policy, then press Enter.

7. Select Create Array using the arrow keys, then press Enter.

3.8.25 Create a RAID1 Array
Note: Refer to Table 7 for RAID1 array characteristics

1. From the RAIDXpert2 Configuration Utility’s Main Menu, select Array Management
using the arrow keys, then press Enter.

2. Select Create Array using the arrow keys, then press Enter.
3. Select Select RAID Level using the arrow keys, then press Enter.

e From the Select RAID Level drop-down menu, use the arrow keys to select
RAID1, then press Enter.

4. Select the disks to create the array:
e Select Physical Disks using the arrow keys, then press Enter.

e Select desired disks, highlight a disk with the arrow keys and press the space bar
or Enter.

e Select Apply Changes using the arrow keys, then press Enter.
Note: Refer to Table 16 on page 43 for Default Cache Tag Size.

5. Select Read Cache Policy using the arrow keys, then press Enter.
e Select the desired Read Cache Policy, then press Enter.

6. Select Write Cache Policy using the arrow keys, then press Enter.
e Select the desired Write Cache Policy, then press Enter.

7. Select Create Array using the arrow keys, then press Enter.

3.8.2.6 Create a RAID10 Array
Note: Refer to Table 7 for RAID10 array characteristics

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.

2. Select Create Array using the arrow keys, then press Enter.
3. Select Select RAID Level using the arrow keys, then press Enter.

e From the Select RAID Level drop-down menu, use the arrow keys to select
RAID10, then press Enter.
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4. Select the disks with which to create the array:
e Select Physical Disks using the arrow keys, then press Enter.

o Select desired disks, highlight a disk with the arrow keys and press the space bar
or Enter.

e Select Apply Changes using the arrow keys, then press Enter.
Note: Refer to Table 16 on page 43 for Default Cache Tag Size.

5. Select Read Cache Policy using the arrow keys, then press Enter.
e Select the desired Read Cache Policy, then press Enter.

6. Select Write Cache Policy using the arrow keys, then press Enter.
e Select the desired Write Cache Policy, then press Enter.

7. Select Create Array using the arrow keys, then press Enter.

3.8.2.7 Create a RAIDS Array
Note: Refer to Table 7 for RAIDS5 array characteristics.
Note: RAID5 is only supported for AMD Family 17h Models 31h sTRX4 processors.

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.

2. Select Create Array using the arrow keys, then press Enter.
3. Select Select RAID Level using the arrow keys, then press Enter.

e From the Select RAID Level drop-down menu, use the arrow keys to select
RAIDS5, then press Enter.

4. Select the disks to create the array:
e Select Physical Disks using the arrow keys, then press Enter.

e Select desired disks, highlight a disk with the arrow keys and press the space bar
or Enter. Select a minimum of three (3) devices for RAIDS.

e Select Apply Changes using the arrow keys, then press Enter.
Note: Refer to Table 16 on page 43 for the Default Cache Tag Size.

5. Select Read Cache Policy using the arrow keys, then press Enter.
e Select the desired Read Cache Policy, then press Enter.

6. Select Write Cache Policy using the arrow keys, then press Enter.
e Select the desired Write Cache Policy, then press Enter.

7. Select Create Array using the arrow keys, then press Enter.
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3.9 Delete Arrays

CAUTION: Deleting an array permanently destroys all the data on the array. This action cannot
be undone, and it is very unlikely the data can be recovered.

CAUTION: Do not delete the first array listed in the Arrays section if it is the AMD-RAID
bootable array. Doing this deletes the operating system and AMD-RAID files

3.9.1 Delete an Array

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.

2. Select Delete Arrays using the arrow keys, then press Enter.
3. Select the array(s) to delete:

e Select the desired array or multiple arrays using the arrow keys, then press the
space bar or Enter to change option to Enabled for deletion.

e If you want to select all the arrays, use the arrow keys to select Check all, then
press Enter.

e Select Delete Array using the arrow keys, then press the space bar or Enter.

e To select all the arrays for deletion: use the arrow keys to select Check all, then
press the space bar or Enter.

e Review the warning message, if you want to proceed, press the space bar or Enter.
e Select Yes using the arrow keys to delete arrays or press the ESC key to exit.

3.10 Manage Spares
This option allows the user to assign or unassign global or dedicated spares.

Note: To assign a physical disk as a Global Spare, it must not be part of any Array.

3.10.1 Assign Global Spares

1. From the RaidXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Physical Disk Management, then press Enter.

Select Physical Disk Operations using the arrow keys, then press Enter.
Select Select Physical Disk using the arrow keys, then press Enter.
Select Assign Global Hot Spare using the arrow keys, then press Enter.

Review the warning message, if you want to proceed, use the arrow keys to select Yes, or
press ESC or No, to exit.

ok~ wn
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3.10.2 Assign Dedicated Spares

Note:

Dedicated spares can only be assigned to redundant arrays and must the same size or
larger than the other members of the redundant array.

From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.

Select Manage Array Properties using the arrow keys, then press Enter.
Select Select Array using the arrow keys.

e Select the desired array (must be a redundant array) from the drop-down menu,
then press Enter.

Select Manage Dedicated Hot Spares using the arrow keys, then press Enter.
Select the disks to assign as dedicated spares.

e Select the disk using the arrow keys to highlight the disk and press the space bar or
Enter to select it.

e Select Add Hot Spare Physical Disk using the arrow keys, then press Enter.
e At the warning message, press the space bar or Enter to Confirm.

e Select Yes using the arrow keys, then press Enter or press the ESC key to exit
adding the Dedicated Spare.

3.10.3 Unassign Spares

3.11

From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Physical Disk Management, then press Enter.

Select Select Physical Disk Operations using the arrow keys, then press Enter.
Select Select Physical Disk using the arrow keys, then press Enter.

From the drop-down menu, use the arrow keys to select the Global / Dedicated Spare,
then press Enter.

Select Unassign Hot Spare using the arrow keys, then press Enter.

Review the warning message, if you want to proceed select Yes, then press Enter or press
the ESC key to exit.

View Controller Details

This option will display the details about of the controllers. Nothing can be changed using this
menu option; it is for informational purposes only.

1.

From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Controller Management, then press Enter.

Select Select View Controller Information using the arrow keys, then press Enter.
Select Select Controller using the arrow keys, then press Enter.
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4. From the drop-down menu, select the desired controller, then press Enter. Information
about the controller is displayed below the Select Controller header:

e PCIID

e Controller Physical Disk Count

e Total Physical Disk Count

e Total Array Count

e UEFI Driver Version

e Firmware Properties/Firmware Build Time

5. To view another controller, press Enter and from the drop-down menu, select a different
controller, then press Enter.

6. Press ESC to exit to the Main Menu.

3.12 View Disk Details

This option allows the user to view details about the physical disk(s). Nothing can be changed
using this menu option; it is for informational purposes only.

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to highlight
Physical Disk Management, then press Enter.

2. Select View Physical Disk Properties using the arrow keys, then press Enter.
Select Select Physical Disk using the arrow keys, then press Enter.

4. From the drop-down menu, select the physical disk you want more information about, then
press Enter.

5. Information about the physical disk is displayed below the Select Physical Disk header:
e Unique Disk ID
e State
e Size
e Smart Status
e Revision
e Drive Type
e Maximum Free Space
e Used Space
e Disk Protocol
e Disk Speed
e Associated Array, if part of one
e Serial Number
e Model Number

w
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6. To view another physical disk, press Enter and from the drop-down menu, select a
different physical disk, then press Enter.

7. Press ESC to exit to the Main Menu.

3.13 View Array Details

This option will display the details of an array. Nothing can be changed using this menu option; it
is for informational purposes only.

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.

2. Select Select Manage Array Properties using the arrow keys, then press Enter.
3. Select Select Array using the arrow keys, then press Enter.
4. From the drop-down menu, select the desired array, then press Enter.
5. Select View Associated Physical Disks using the arrow keys, then press Enter
6. Press the space bar to select one of the members of the Array
7. Select View Physical Disk Properties using the arrow keys, then press Enter
8. Information about the array is displayed below the Select Array header:

e Array number

e RAID level

e State (see Table 8)

e Size

e Cache Tag Size

e Cache settings

e Associated physical disks
9. To view another array, press ESC twice and perform steps 2 through 8 again.
10. Press ESC to exit to the Main Menu.

3.14 Rescan All Channels

This option allows the user to rescan all channels to detect new or removed disks and arrays. It
rereads the configuration information from each disk.

Sometimes when a disk is offline, it can be brought online through a rescan.

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Controller Management, then press Enter.

2. Select Rescan Disks using the arrow keys, then press Enter.
e After a rescan completes, all of the physical disks are displayed.
3. Select OK using the arrow keys, then press Enter.

50 Platform BIOS RAID Configuration Prerequisites Chapter 3



AMDA

53987 Rev. 3.11 June 2020 AMD-RAIDXpert2 User Guide

Chapter 4 Software Installation

This chapter is designed to assist you with installation of Operating systems, by performing these
general procedures:

4.1 System Setup Process Overview

A generic system setup process follows these steps:

1. Copy the AMD-RAID drivers to a removable storage medium.
2. Power ON the system.

3. To enable RAID refer to Chapter 3, Platform BIOS RAID Configuration Prerequisites, on
page 36. (This enables the loading of the AMD-RAID Option-ROM and or AMD-RAID
UEFI driver).

4. Initialize the disks using the AMD-RAID Array Configuration Utility (HIl) or AMD-
RAID Option-ROM.

5. Create arrays using the AMD-RAID Array Configuration Utility (HIl) or AMD-RAID
Option-ROM.

6. Install the AMD-RAID drivers on the system.

7. Load the operating system.

8. Install the OS RAID Management Suite (AMD RAIDXpert2) on the system.

Note: To protect your data, always perform a backup prior to installing any new, major hardware
or software.

4.2 Before You Begin

Have the Windows® or Linux® operating system software available and ready to install.

4.3 Copying AMD-RAID Drivers to Removable Storage

Copy the drivers to a removable storage medium before starting the installation.

4.3.1 Copying AMD-RAID Drivers in a Microsoft® Windows®
Environment

1. Power ON the system.

2. Locate and use a system that is running a Windows operating system and has a CD DVD
drive or an 1/O port for removable storage media (such as a USB flash drive).

3. Go to a browser and access the web site of your system supplier or motherboard vendor.
4. Insert the storage medium into the system:
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e Connect a USB flash drive to a USB 1/O port or insert a blank CD-DVD disk into
the applicable drive.

5. Download the AMD-RAID drivers from the web site to the appropriate removable storage
medium.

4.3.2 Copying AMD-RAID Drivers in a Linux® Environment

1. Power ON the system.

2. Locate and use a system that is running a Windows operating system and has a USB 1/O
port for the USB flash drive.

3. Use a browser to access the web site of your system supplier or motherboard vendor.
4. Insert a USB flash drive into the USB 1/O port of the system.

5. Download the AMD-RAID drivers for the correct distribution version of Linux®. Copy the
drivers onto the USB flash drive:

e For Red Hat Linux: Copy the .iso image file (that matches the applicable
distribution of Linux to the USB flash drive . For example:

dd-rcraid-RHEL8-4-18.0-193.e18.x86 64.iso
e For Ubuntu: Copy the driver files contained inside the dd-rcraid-Ubuntu [Ubuntu

version number].w.x-yz-folder into a dd directory located on a root path of the USB
flash drive. For example:

dd

e load amdraid

e post_install

e post_install2

e pre_install

e rcraid.ko

e rcraid_generic.ko
e readme
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4.4 Installing AMD-RAID Drivers

Follow the procedures below for Pre-install of AMD RAID Driver during Installation of your
Microsoft Windows or Linux® Operating System.

44.1 Installing AMD-RAID Drivers While Installing Microsoft®
Windows®

Note: The windows described in this procedure are typical. Path names and text can vary,
depending on user-designated selections and other parameters.

Note: NVMe devices are listed in the “Where do you want to install Windows?” do not delete any
of the partitions or format the devices. Doing so will delete the AMD-RAID metadata and
the desired RAID level will be deleted. After AMD-RAID drivers have been loaded, a valid
AMD-RAID Virtual Disk appears.

Note: If a user wants to add or remove a NVMe into a system; it is AMD’s recommendation that a
reset of the system is performed, wait for the BIOS screen to appear, then power off the
system and add or remove the NVMe(s).

Power ON the system.
Create a bootable array, refer to Section 3.8, Create Arrays, on page 42.
Insert the Microsoft Windows operating system media/disk into the system’s Optical drive.

Boot the system and allow it to access the Microsoft Windows operating system
installation media/disk.

5. At the Windows setup window:

Select the language, time, and keyboard options
Click Next.

Click Install Now or similar.

If prompted, select the desired Operating System.
Click Next.

Depending on the installation window observed, choose one of the methods below to
load rcbottom.inf.

g. If the window observed is Select driver to install:

I. Insert the storage medium with the AMD-RAID drivers into the USB port or
applicable system drive.

M owbdhe

-~ 0 0 T @

ii. Click Browse.

iii.  Navigate to the directory containing the saved AMD-RAID drivers.
iv. Click OK.

v. Select the first rcbottom.inf driver in the list.
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vi. Click Next.

Note: If the installation has multiple controllers, there will be two or more rcbottom.inf’s
listed, installation of rcbottom. inf is recommended only once.

h. Else follow onscreen prompt until Where to install Windows? window observed:
i. Select Load driver.

ii. Click Browse.

ili. Navigate to the directory containing the saved AMD-RAID drivers.
iv. Click OK.

v. Select the first rcbottom.inf driver in the list.

vi. Click Next.

6. Atthe Load Driver window:
a. Click OK.
Click Browse.
Navigate to the directory containing the saved AMD-RAID drivers.
Click OK.
Select the rcraid.inf driver from the list.
. Click Next.
7. Select (Check Mark) the I Accept the License Terms.
a. Click Next.
b. Select Custom: Install Windows Only (advanced) or similar.

8. After both the rcbottom and rcraid drivers have been loaded, a valid Virtual disk appears
in Where do you want to install Windows? window:

-~ 0o o 0 T

a. Click Load Drivers.

b. Click Browse.

c. Navigate to the directory containing the saved AMD-RAID drivers.
d. Click OK.

e. Select the rccfg.inf driver in the list.

f. Click Next.

g. Atthe Where do you want to install Windows, click Next.

9. Follow the on-screen instructions to complete the installation of the applicable Windows
operating system.

10. After the OS is installed, open Device Manager and verify the following:
a. Expand Storage Controllers: there are entry(ies) listed as AMD-RAID Bottom Device.
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b. Expand Storage Controllers: there are entry(ies) listed as AMD-RAID Controller.
c. Expand System Devices: there is an entry listed as AMD-RAID Config Device.

11 Remove the storage medium and Microsoft Windows OS CD-ROM or DVD from the
applicable drive(s) or port. Proceed to Section 4.4.2, Windows — AMD-RAIDXpert2
Management Suite Desktop Application (Microsoft Store), on page 55

442 Installing the AMD RAIDXpert2 Management Suite for Microsoft®
Windows®

Install this software using one of the following:

e From the Microsoft Store at https://www.microsoft.com/store/apps.
e From the AMD support web site at https://support. AMD.com.

443 Windows — AMD-RAIDXpert2 Management Suite Desktop
Application (Microsoft Store)

1. Go to the Microsoft Store at https://www.microsoft.com/store/apps.

2. Select Search, type AMD-RAIDXpert2, and select the AMD-RAIDXpert2 Management
Suite Desktop Application from the search results.

3. Select Get.
4. Sign in with your Microsoft account to finish downloading the application.

5. After the RAIDXpert2 software installation is completed, open the Windows menu and
search for AMD RAIDXpert2, then click Open.

444 Windows — AMD-RAIDXpert2 Management Suite
The procedures in this section describe how to install the software from the AMD support website.

1. Obtain the latest executable file from your system supplier, motherboard vendor, or from
https://www.amd.com/support.

2. Download the file to the system’s desktop, run it and follow the on-screen prompts.
3. Double-click the RAIDXpert2 desktop icon.

4.4.5 Windows — AMD RAIDXpert2 Management Suite Installation
Desktop Application (Manual Install)

Note: AMD RAIDXpert2 Management Suite installation default is a Silent installation.

1. Obtain the AMD RAIDXpert2 Management Suite executable file (setup.exe) from
your system supplier or motherboard vendor. Download Setup.exe to the system’s
desktop.
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2. Install AMD RAIDXpert2 (setup.exe).
3. Open a command prompt, with the Run as Administrator option.
4. Type cd C:\User\User_Name\Desktop.
e For silent installation: setup.exe
e For GUI installation: setup.exe -i gui
5. Turn off the Windows Firewall (or unblock during step 2).
6. Click on the RAIDXpert2 Desktop icon.

See Section 6.1 page 77 for more information.

4.5 Installing AMD-RAID Drivers While Installing
Linux® Operating System

Note: The Linux® operating system modules must include the gcc+ compiler and the pthreads
library so that the rcadm program can be installed properly.

4.5.1 Install the AMD-RAID drivers during an Ubuntu Desktop Linux
Installation

Note: Prior to starting this procedure, obtain the AMD-RAID drivers from your system supplier or
motherboard vendor.

e Copy the AMD-RAID drivers to a dd directory on a USB flash drive formatted as FAT32.
See Copy AMD-RAID drivers: Linux.

Note: The Ubuntu driver CD-ROM .iso image contains all Linux variations for a release.
Note: Not all of the windows indicated in this procedure will appear during the installation.

Note: If a user wants to add or remove a NVMe into a system; it is AMD’s recommendation that a
reset of the system is performed. Wait for the BIOS screen to appear, then power off the
system and add or remove the NVMe(s).

1. Power ON the system.

2. To prevent the system from updating, remove the Ethernet Cable from the system.
Reinstall the Ethernet Cable after the update.

3. Insert the Ubuntu Desktop Linux operating system CD-ROM or DVD into the system’s
CD or DVD drive.

4. Boot to the Ubuntu Desktop CD-ROM, DVD or USB Flash drive, this will bring you to the
GNU Grub Window.

e Press the down arrow to Ubuntu or similar.

e Pressthe E key.
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At the end of the Boot Options linux string, add the following:

break=mount modprobe.blacklist=ahci,nvme

Note: The string should look like the following: Due to some video cards being different,
there may be some variation in the string.

splash --- break=mount modprobe.blacklist=ahci,nvme

e Press F10

Note: If the BusyBox shell doesn’t appear (the screen is black) reset the system and try with
the following settings:

e Type:break=mount modprobe.blacklist=ahci,nvme nomodeset

Note: The string should look like the following:

splash --- break=mount modprobe.blacklist=ahci,nvme nomodeset

e Press F10

5. Complete the following when the BusyBox shell displays:
e Insert the USB flash drive.
e Type:mount -t vfat /dev/sdbl /tmp

Note: /dev/sdbl may need to be changed to /devisdcli or /dev/sddl ...depending on the
number of devices. Enter - Is /dev/sd*, this will list the possible entries.

e Type:cp -ap /tmp/dd /

e Type: /dd/pre install (Wait for the install to complete, this may take some
time.)

e unmount /tmp
e Type: Exit
e Remove the USB flash drive

6. Wait for the Welcome screen to load. Goes to different screen on the new install 20.04
something like for 20.04 this will load.

Note: If the Welcome screen doesn’t open but the Ubuntu Desktop displays with the Install
Ubuntu icon available, double-click on Install Ubuntu Desktop icon.

7. Click Ubuntu.
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8. Select the desired Language from the Keyboard layout window and click Continue.

9. Select Normal Installation from the Updates and Other Software window and click
Continue.

10. Select Erase Disk and Install Ubuntu from the Installation Type window and click
Install Now.

11. Select the drive from the Erase disk and install Ubundu screen and click Continue or
Install Now. Write Changes to Disks? window.

12. Select the desired Time Zone and click Continue.
13. Enter valid entries for Who are you? with the following:
e Your name
e Computer name
e Username
e Password
e Confirm Password
e Click Continue
14. When the Installation Complete window displays, complete the following:
e Press CTRL+ALT+F2
e From the Ubuntu Login prompt, enter ubuntu, then press Enter

Note: If asked for a password, press Enter, without entering a password.

e Insert the USB flash drive used in a previous step
e Enter: sudo mount -t vfat /dev/sdbl /mnt

Note: /dev/sdbl may need to be changed to /dev/sdcl or /dev/sdd] ...depending on the
number of devices. Enter - Is /dev/sd*, this will list the possible entries.

e Enter: sudo cp -ap /mnt/dd /
e Enter: sudo /dd/post install

15. Wait for the message Setup is Complete, press CTRL+ALT+F1, click Restart Now to
finish the installation.

16. Remove the installation media:

e If prompted, remove the CD/DVD or DVD and USB flash drive

e When installation media is removed, press Enter or Reboot the system
17. Reconnect the Ethernet Cable.

4.5.2 Install the AMD-RAIDXpert2 Management Application

1. Contact your system supplier or motherboard vendor to obtain the new AMD-RAID Linux
Management Application.
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2. Copy the AMD-RAID 9.3.0-00xxx_linux_raidxpert2.tgz to a USB flash drive.

3. Insert a USB flash drive containing the AMD-RAID 9.3.0-00xxx_linux_raidxpert2.tgz
package.

4. Click Files
e Select the USB that was inserted above

e Locate and select the AMD-RAID 9.3.0-00xxx_linux_raidxpert2.tgz package and
drag it to the /home directory on your desktop.

¢ Right-click to open the Terminal or click the Terminal icon.

e Enter sudo tar xzvf 9.3.0-00xxx linux raidxpert2.tgz -C /opt.
5. To open the AMD RAIDXpert2 Management Application:

e Enter cd /opt/raidxpert2/bin.

e Enter ./RAIDXpert2 &.

453 Install the AMD RAID Drivers During a RHEL Linux Installation

Note: Prior to starting this procedure, obtain the AMD-RAID drivers from your system supplier or
motherboard vendor.

e Copy the AMD-RAID drivers to a USB flash drive
e See Copy AMD-RAID drivers: Linux

Note: When installing Red Hat Linux, use the Linux dd installation mode instead of the Linux
expert mode.

Note: Not all of the windows indicated in this procedure will display during installation.

Note: If a user wants to add or remove a NVMe into a system, it is AMD’s recommendation that a
reset of the system is performed, wait for the BIOS screen to appear, then power off the
system and add or remove the NVMe(s).

Power-ON the system

Insert the Red Hat installation CD-ROM, DVD or USB.
Create a bootable array, see Section 3.8.2.1 page 43

At the Red Hat Enterprise Linux Welcome window:
e Press the Up Arrow.

e Select Install Red Hat Enterprise Linux 8.x (the text should be high-lighted in
white).

e PressE.
e Press the down arrow twice and select the linuxefi /images string.
e Press the END key.

D ownhde
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b

e Add“inst.dd modprobe.blacklist=ahci modprobe.blacklist=nvme’
to the end of the string.

Example: 1inuxefi /images....quiet inst.dd modprobe.blacklist=ahci

modprobe.blacklist=nvme.

e PressCTRL X.

Note: If the shell doesn’t display (the screen is black) reset the system and try with the

following settings:

e Addinst.dd modprobe.blacklist=ahci modprobe.blacklist=nvme
nomodeset to the end of the string:

Example: 1inuxefi /images....quiet inst.dd modprobe.blacklist=ahci

modprobe.blacklist=nvme nomodeset

e PressCTRL X.

. At the Driver Disk Device Selection:

e Insert the USB drive (which contains the AMD-RAID dd-rcraid....x86 64.is0)
into the USB port.

e Pressr.

e Press Enter to refresh.

e Press X (x representing the number of USB flash drives inserted previously.
e Press Enter.

. At the Choose Driver Disk ISO file:

e Press 1 — number of the dd-rcraid-RHEL....el8.x86 64.iso entry.
e Press Enter.

. At the Select Drivers to Install:

e Press 1 — number of the /media/DD/....x86_64.rpm entry.
e Press Enter.
The /media/DD/...is now selected and should look like [X]
/media/DD/.....x86 64.rpm.
e Pressc.
e Press Enter.

. At the Driver Disk Device Selection:

e Pressc.
e Press Enter.
e Remove the USB flash drive.

. At the Welcome to Red Hat Enterprise Linux screen:

e Choose the desired Language.
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e Choose the desired Country.
¢ In the bottom-right corner, click Continue.
10. At the Installation Summary screen, configure the following:
e Under Localization:
e Keyboard
e Language Support
e Time and Date
e Under Software:
Software Selection
Under Base Environments
Select Server with GUI
In the upper-left corner, click Done
e Under System:
e Installation Destination
e Under Local Standard Disks.
e Select AMD-RAID Array 01.
e Under Storage Configuration.
e Select Custom.
e In the upper-left corner, click Done.
e Click the Click here to create them automatically link.

Note: AMD-RAID only supports a file system type of ext4, using the XFS file system
will cause an unrecoverable installation error.

. Under Installation:
e Select DATA/home.
e Change File System from xfs to ext4.
e Select SYSTEM/rhel-root.
e Change File System from xfs to ext4.
e Select SYSTEM/boot.
e Change File System from xfs to ext4.
e In the upper-left corner, click Done.
In the Summary of Changes window, click Accept Changes.
e Under Network and Hostname.
¢ In the bottom-left corner, enter a valid Hostname, the press the Apply button.
e Select an Ethernet Port.
e In the bottom-right corner, click Configure.
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Enter valid entries.
Click Save.
Under Ethernet, click the ON button.
In the upper-left corner, Click Done.
11. In the bottom-right corner, click Beginning Installation.
12. At the Configuration window:
e Click Root Password
e Enter an applicable root password
e Re-enter the root password
e In the upper-left corner, click Done
e Click User Creation
Enter a Full Name
Enter a Username
Enter an applicable password
Re-enter the user password
In the upper-right corner, click Done

Note: Wait for the “Red Hat Enterprise Linux is now successfully installed and ready
for you to use! Go ahead and reboot to start using it! ” zo appear

o In the bottom-right corner, click Reboot
o Remove the installation media
13. At the Initial Setup window
e Under Licensing
e Click License Information
e Review the EULA and select (check mark) I accept the License Agreement
e In the upper-left corner, click Done
e Under System
e Configure Subscription Manager
e In the bottom-right corner, click Finish Configuration
14. Login to the system
e Select a user
e Enter a password
15. At the Welcome window
e Select the desired Language
e Click Next
16. At the Typing window
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e Select the desired Language
e Click Next
17. If desired, configure Privacy
e Click Next
18. At the Connect your Online Accounts
e  Configure or click Skip
19. Click Start using the Red Hat Enterprise Linux Server

454 Install the RAIDXpert2 Management Application

1. Contact your system supplier or motherboard vendor to obtain the new AMD-RAID Linux
Management Application.

2. Copy the AMD-RAID 9.3.0-00xxx_linux_raidxpert2.tgz to a USB flash drive.

3. Insert a USB flash drive, formatted as FAT32.

4. Log into the system as root Or su root.

5. Click Activities->Files and select the USB flash drive inserted previously.

6. Locate and select the AMD-RAID 9.3.0-00xxx_linux_raidxpert2.tgz package and drag it to
/home on your desktop.

7. Click Activities->Terminal to open a terminal / console window.

8. Enter tar xzvf 9.3.0-00xxx linux raidxpert2.tgz -C /opt.
9. To open the AMD-RAID RAIDXpert2 Management Application:
e Click Activities->Terminal to open a terminal / console window.
e Entered /opt/raidxpert2/bin.
e Enter . /RAIDXpert2 &.

Note: “Cannot Open Display "Error While Launching RAIDXpert2 on RHEL 8.x. When
the latest RAIDXpert2 Management Utility is executed, you may receive an error
that looks like: gt.gpa.xcb: could not connect to display :0

RHEL requires elevated permissions to run the program, use the following commands to
create temporary elevated session permission:

e Open a terminal window to allow clients to connect from any host using xhost+.

e The following commands must be entered as a non-root user:

Enter the following command: xhost+

access control disabled, clients can connect from any host
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This will grant the user temporary elevated permissions to run the program. Please note,
once you reboot or update the program, you will have to re-enter these commands to
regrant yourself these permissions.

4.5.5 Install the AMD-RAID drivers during a Debian Linux Installation

Note: Prior to starting this procedure, obtain the AMD-RAID drivers from your system supplier or
motherboard vendor.

e Copy the AMD-RAID drivers to the dd directory on a USB flash drive.
e See Copy AMD-RAID drivers: Linux.

Note: The Debian driver CD-ROM .iso image contains all Linux variations for a release.
Note: Not all the windows indicated in this procedure will appear during the installation.

Note: If a user wants to add or remove a NVMe into a system; it is AMD’s recommendation that a
reset of the system is performed, wait for the BIOS screen to appear, then power off the
system and add or remove the NVMe(s).

=

Power-ON the system.
Insert the Debian Linux operating system CD-ROM, DVD or USB Flash drive into the system.
3. Boot to the Debian CD-ROM, DVD or USB Flash drive, this will bring you to the GNU
GRUB Window

» Select Graphical Install

* Press the E key
Press the down arrow to the Linux /install....quiet entry

e Press the END key

* Add the following linux string: modprobe .blacklist=ahci,nvme

N

Note: The string should look like: --- quite
modprobe .blacklist=ahci, nvme
*  Press F10

4. At the Debian installer main menu
* Press CTRL ALT F2
» Atthe Please press Enter to activate this console, press Enter
* Insert the USB flash drive that contains the AMD-RAID Debian driver
 Type: mount -t vfat /dev/sdbl /tmp

Note: /dev/sdbl may need to be changed to /dev/sdcl or /dev/sdd!...depending on the
number of devices. Enter - Is /dev/sd*, this will list the possible entries.

* Type:cp —ap /tmp/dd /
* Type: /dd/pre_install
* Type: umount /tmp
* Type: exit
* Remove the USB flash drive
* PressCTRL ATL F5
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5. From the Debian Select a Language window

Select the desired Language, then click Continue

Select the desired Location, then click Continue
Configure the keyboard, then click Continue

Select the desired network, configure, then click Continue

6. Enter a valid Hostname, then click Continue

Enter a valid Root password

Re-enter a valid password, then click Continue

Enter a Full name for the New User, then click Continue

If Username for your account is acceptable, then click Continue
Enter a valid New User password

Re-enter the New User password, then click Continue

Select the desired Time Zone, then click Continue

7. At the partition disk, force UEFI installation, select Yes, then click Continue

At the partition disk, Partitioning method, select Guided — use entire disk, then click
Continue

At the partition disks, Select disk to partition, select the AMD-RAID Array, then click
Continue

At the partition disks, Partitioning scheme, select the All files in one partition
(recommended for new users), then click Continue

At the partition disks, select Finish partitioning and write changes to disk, then click
Continue

At the partition disks, Write changes to disks?, select Yes, then click Continue

8. At the Configure the package manager window, Use a network mirror?, select Yes, then
click Continue

At the Configure the package manager, Debian archive mirror country, select the
desired Country, the click Continue

At the Configure the package manager, Debian archive mirror;, select a mirror, then
click Continue

At the Configure the package manager, HTTP proxy information, enter an address or
leave blank, the click Continue

At the Configuring popularity-contest, Select Yes or No, then click Continue

At the Software selection, select the desired additional packages, then click Continue

9. When the “Finish the Installation” window appears, then do the following:

Note

Press CTRL+ALT+F2

At the Please press Enter to activate this console, press Enter
Enter: /dd/post_install

Wait for the Setup is Complete

Press CTRL+ALT+F5

Click Continue, to finish the installation.

Remove the installation media.

: The Debian installation may not work with the latest gpu’s. After the installation and

reboot, the system starts to boot but never boots to the desktop.
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The following steps are for installing the AMD Linux graphics drivers:

1. Go to support.amd.com and download the AMD Linux graphics tar file and copy it to a USB
flash drive.
2. At the blinking cursor in the upper right corner:
Press CTRL ALT F2
Enter: root, then press Enter
Enter the root password, then press Enter
Insert the flash drive with the AMD tar file on it.
Mount the flash drive and copy AMD Linux graphics tar file to the test system
umount the flash drive
Enter: vi /etc/apt/sources.list
h. Add a # at the beginning of the deb cdrom line, to comment it out, then save (:wq) and
exit
Enter: apt update
Enter: apt install dkms -y
. Enter: ca /
Enter: tar xvf amdgpu.... /
. Enter: ecd amdgpu..., then press Enter
Enter: dpkg -i amdgpu-core ..... amdgpu-dkms_. ..., then press Enter

3. Wait for the command to complete, then reboot the system

4.5.6 Install the AMD-RAIDXpert2 Management Application

Contact your system supplier or motherboard vendor to obtain the new AMD-RAID Linux
Management Application.

@me oo o
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1. Copy the AMD-RAID 9.3.0-00xxx_linux_raidxpert2.tgz to a USB flash drive.
2. Insert a USB flash drive containing the AMD-RAID 9.3.0-00xxx_linux_raidxpert2.tgz
package.
3. Click Files/File Manager or similar
e Select the USB that was inserted above
e Locate and select the AMD-RAID 9.3.0-00xxx_linux_raidxpert2.tgz package and drag it to
the /home section
4. Install the AMD RAIDXpert2 Management Application
e Click the Terminal icon
e Enter - su - root, then press Enter
e Enter the password for the root account, then press Enter
e Change directories to the location of the AMD-RAID 9.3.0-00xxx_linux_raidxpert2.tgz
package (cd /home/newuser
e Enter — tar xvzf 9.3.0-00xxx_linux_raidxpert2.tgz -C /opt
5. To open the AMD-RAID RAIDXpert2 Management Application
e Click the Terminal icon
e Enter—cd /opt/raidxpert2/bin
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e Enter - ./RAIDXpert2 &
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Chapter 5 RAID Software Update

5.1 Purpose

This chapter describes the steps needed to update the AMD-RAID drivers installed on the
following Operating Systems:

e Microsoft Windows 10 64 bit

e Ubuntu Desktop Linux 20.04 64 bit

e Red Hat Enterprise Linux (RHEL) 8.x
e Debian 10.3 64 bit

5.2 System Overview Process

A generic System update process is described below.

Backup the user data before doing any upgrade.

Power-ON the system.

Log into the system.

Copy the AMD RAIDXpert2 Installer to the Systems Desktop.

e Windows — Latest package from AMD (https://www.amd.com/support) — See 1.1 on
pagel6.
e Windows — Manual install, use Setup.exe — See Section 1.2 on page 16.
Linux — Setup.sh
5. Run the AMD RAIDXpert2 Installer to update the AMD RAIDXpert2 Management Suite.
6. Update the AMD-RAID OS drivers.
7. Restart the System.

M owbdhe

IMPORTANT: To protect your data; always perform a backup prior to installing any new, major
hardware or software. If you are adding NVMe as RAID to your existing AMD-
RAID arrays, update all the existing AMD-RAID controller drivers to the latest
version and restart the system. Then connect the NVMe devices and install the
AMD-RAID driver onto NVMe devices.

5.3 Updating the AMD RAIDXpert2 Management Suite.

The following sections will give you information on updating AMD RAIDXpert2 Management
Suite.
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5.3.1 AMD RAIDXpert2 UWP Management Suite

If you have the AMD-RAIDXPert2 UWP Management Suite installed, when a new version is
release to the Microsoft store, it will be pushed to the system and automatically updated.

53.1.1 Windows — AMD-RAIDXpert2 Management Suite Desktop Application
(Microsoft Store Manual Update)

1. Go to the Microsoft Store at https://www.microsoft.com/store/apps.

2. Select Search, type AMD-RAIDXpert2, and select the AMD-RAIDXpert2 Management
Suite Desktop Application from the search results.

3. Select Get.
4. Sign in with your Microsoft account to finish downloading the application.

5. After the RAIDXpert2 software installation is completed, click on the RAIDXpert2
Desktop icon.

6. Re-log into the system with the new credentials.

532 Update the AMD RAIDXpert2 Management Application (GUI)—
AMD RAID Installer

To update the AMD RAIDXpert2 Management Application AMD RAID Installer, complete the
following:

1. Backup the user data before doing any upgrade.
2. Power-ON the system.

3. Obtain the latest AMD RAID Installer executable file from your system supplier or
motherboard vendor. Download the file to the Systems Desktop and execute it. Follow the
on-screen prompts.

5321 Update the AMD RAIDXpert2 Management Application (GUI)—Manually

1. Backup the user data before doing any upgrade.
2. Open a browser and access the Web Site of your system supplier or motherboard vendor.

3. Download the AMD RAIDXpert2 Installer (setup.exe) from the web site and copy it to the
Systems Desktop.

4. Open a Command Prompt terminal
Enter: cd \Users\user name\Desktop
Enter: setup.exe
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5.3.3 Ubuntu — Update the AMD-RAIDXpert2 Management Application

Contact your system supplier or motherboard vendor to obtain the new AMD-RAID Linux
Management Application.

1.

Copy the AMD-RAID 9.3.0-00xxx_linux_raidxpert2.tgz package and drag it to the /home
directory on your desktop.

Insert a USB flash drive containing the AMD-RAID 9.3.0-00xxx_linux_raidxpert2.tgz
package.

Click Files.
e Select the USB that was inserted in the previous step

e Locate and select the AMD-RAID 9.3.0-00xxx_linux_raidxpert2.tgz package and
drag it to the /home section

Install the AMD RAIDXpert2 Management Application

e Right-click on the Terminal or click the Terminal icon

e Enter sudo tar xzvf 9.3.0-00xxx linux raidxpert2.tgz -C /opt
To open the AMD-RAID RAIDXpert2 Management Application

e Click the Terminal icon

e Enter cd/opt/raidxpert2/bin

e Enter ./RAIDXpert2 &

534 RHEL - Update the AMD-RAIDXpert2 Management Application

Contact your system supplier or motherboard vendor to obtain the new AMD-RAID Linux
Management Application.

1.
2.

Copy the AMD-RAID 9.3.0-00xxx_linux_raidxpert2.tgz to a USB flash drive.

Insert a USB flash drive containing the AMD-RAID 9.3.0-00xxx_linux_raidxpert2.tgz
package.

Log into the system as root or su root.

4. Click Activities->Files and select the USB flash drive inserted previously.

5. Locate and select the AMD-RAID 9.3.0-00xxx_linux_raidxpert2.tgz package and drag it to
the /home section.

6. Enter tar xzvf 9.3.0-00xxx linux raidxpert2.tgz -C /opt.

7. Click Activities->Terminal to open a terminal / console window.

8. Enter cd /opt/raidxpert2/bin.

9. Enter ./RAIDXpert2 &.

Note: “Cannot Open Display” Error While Launching RAIDXpert2 on RHEL 8.x. When the latest
RAIDXpert2 Management Utility is executed, you may receive an error that looks like:
gt.gpa.xch: could not connect to display :0
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RHEL requires elevated permissions to run the program, use the following commands to
create temporary elevated session permission:

e Open a terminal window to allow clients to connect from any host using xhost+.
e The following commands must be entered as a non-root user:
Enter the following command: xhost+

access control disabled, clients can connect from any host

This will grant the user temporary elevated permissions to run the program. Please note,
once you reboot or update the program, you will have to re-enter these commands to
regrant yourself these permissions.

.3.5 Debian — Update the AMD-RAIDXpert2 Management Application

Contact your system supplier or motherboard vendor to obtain the new AMD-RAID Linux
Management Application.

1.
2.

3.

Copy the AMD-RAID 9.3.0-00xxx_linux_raidxpert2.tgz to a USB flash drive.
Insert a USB flash drive containing the AMD-RAID 9.3.0-00xxx_linux_raidxpert2.tgz
package.
Click Files/File Manager or similar
e Select the USB that was inserted above
e Locate and select the AMD-RAID 9.3.0-00xxx_linux_raidxpert2.tgz package and drag it to
the /home section
Install the AMD RAIDXpert2 Management Application
e Click the Terminal icon
e Enter - su - root, then press Enter
e Enter the password for the root account, then press Enter
e Change directories to the location of the AMD-RAID 9.3.0-00xxx_linux_raidxpert2.tgz
package (cd /home/newuser
e Enter — tar xzvf 9.3. 0-00xxx_linux_ raidxpert2.tgz -C /opt.
To open the AMD-RAID RAIDXpert2 Management Application
e Click the Terminal icon.
e Enter cd /opt/raidxpert2/bin
e Enter— ./RAIDXpert2 &.

5.4 Updating the AMD-RAID OS Drivers — SOC and

AMD 300-Series Chipset

54.1 Windows—AMD RAID Installer

Contact your system supplier or motherboard vendor to obtain the new AMD-RAID Windows
Installer.
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1. Unzip the AMD RAID installer and execute AMD_RAID_Software.exe or similar. Wait
for the installer to load.

2. Agree to the Terms and Conditions.
3. Click Install. Wait for the installer to complete.
4. Click Restart now to reset the computer and load the new drivers.

54.2 Windows 10—Manually

1. Backup the user data before doing any upgrade.
2. Open a browser and access the Web Site of your system supplier or motherboard vendor.

3. Download the AMD-RAID Drivers from the Web Site and copy it to the Systems C:
drive.

4. Open Computer Management -> Device Manager.
5. Expand Storage Controllers.
6. Select the first AMD-RAID Bottom Device:
e Right click and select Update Driver Software.
e Click Browse my computer for driver software.
e Click Browse, set the path to the Systems C drive.
e Click OK.
e Click Next.
Note: If a Window Security Window pops up, select Install this driver software anyways.

e Click Close.

e At System Settings Change pop up prompting the user to restart the system, Click
No.

7. Select the first AMD-RAID Controller:

Right click and select Update Driver Software.

Click Browse my computer for driver software.

Click Browse, set the path to the Systems C drive.

Click OK.

Click Next.

Note: If a Window Security Window pops up, select Install this driver software anyways.

e Click Close.

e Click No at the System Settings Change pop up prompting the user to restart the
system.

8. Expand System Devices.
9. Select AMD-RAID Config Device:
¢ Right click and select Update Driver Software.
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e Click Browse my computer for driver software.
e Click Browse, set the path to the Systems C drive.
e Click OK.
e Click Next.
Note: If a Window Security Window pops up, select Install this driver software anyways.

e Click Close.
10. Restart the System.

5.5 Linux® Drivers

5.5.1 Ubuntu — Update Drivers or Resync with an Updated Ubuntu
Kernel

Note: If not already done, complete Section 5.3.3 page 70 to get the latest AMD-RAID driver_sdk.

1. Click the Terminal icon.
e Network must be enabled and configured.
e Enter sudo apt-get install -y build-essential.

Warning: If the systems kernel version is updated, perform step 2 before the system is
rebooted. Failing to do so may result in the system failing to boot.

2. Change directory to the RAIDXpert2 driver_sdk directory and enter the following:
e cd /opt/raidxpert2/driver_sdk
e sudo ./install

3. Wait for the command to complete and reboot the system.

552 RHEL - Update the AMD-RAID Drivers
Contact your system supplier or motherboard vendor to obtain the new AMD-RAID RHEL driver.

1. Copy the AMD-RAID dd-rcraid-RHELS....x86 64.is0.gz to a USB flash drive.

Insert a USB flash drive containing the AMD-RAID dd-rcraid-RHEL....x86_64.i50.9z
driver disk iso image.

Log into the system as root or su root

Click Activities->Files and select the USB flash drive inserted previously.

Locate and select the AMD-RAID dd-rcraid-RHEL....x86_64.is0.gz.

Right-click and select Copy To-> Other Locations->Computer->root->Desktop.
Click the Select button in the upper-right corner.

N o gk~ ow
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8. Click Activities->Files and navigate to /root -> Desktop and select AMD-RAID dd-
rcraid-RHELS....x86 64.iso.gz.

9. Right-click and select Extract Here.
10. Click Activities->Terminal to open a terminal / console window.
11. Enter ed /root/Desktop/dd-rcraid-RHEL.../rpms/x86 64

12. Enter rpm -i --force kmod-rcraid...x86_ 64 .rpmand wait for the command to
complete.

13. Reboot the system.
14. Remove the USB flash drive.

5.5.3 Debian — Update the AMD-RAID Drivers

Note: If not already done, complete Section 5.3.5 on page 71 to get the latest AMD-RAID
driver_sdk.

1. Opena Terminal:
a. Network must be enabled and configured.
b. Enter- su - root, then press Enter.
c. Enter the password for the root account, then press Enter.
d. Enter —apt install -y build-essential.

Warning: If the systems kernel version has been updated, perform step 3 before the system
is rebooted, failing to do so may result in the system failing to boot.

2. Change directory to the RAIDXpert2 driver_sdk directory and enter the following:
* cd /opt/raidxpert2/driver_ sdk
* ./install

3. Wait for command to complete.

4. Reboot the System.

5.6 Adding NVMe to Existing AMD-RAID System

5.6.1 Update Windows® 10 Drivers for SoC and AMD 300/400/500-Series
Chipsets

1. Backup the user data before doing any upgrade.
2. If not already done, perform the steps in Section 5.3.2.1 on page 69.
3. If not already done, perform steps in Section 5.4.1 on page 71.

5.6.2 Update Platform BIOS

1. Flash the BIOS with a version that supports AMD-RAID NVMe RAID
2. Enable RAID onthe SOC, Chipset and NVMe
3. Save the BIOS settings
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4. Power off the system
5. Install the NVMe devices
6. Power on the system

5.6.3

Install the AMD-RAID Driver for NVMe

1. Open Device Manager.
2. Expand Storage Controllers.

a.

—STe "® o0 o

[

Note:

Note:
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X.

Select the desired Standard NVM Express Controller

Right click and select Update Driver Software.

Click Browse my computer for driver software.

Click Let me pick from a list of available drivers on my computer.
Click Have Disk.

Click Browse, set the path to the Systems C: drive.

From the list, select the rcbottom.inf entry.

Click Open.

Click OK.

Click Next.

If a Window Security Window pops up, select Install this driver software anyways.

Click Close.

Click No at the System Settings Change pop up, prompting the user to restart the
system.

. Perform Step 2 for each additional NVMe device you want to run RAID.

Expand Other Devices.

Select the desired Unknown Device.

If you are unsure which entry to use, select an Unknown Device, Right click and
select Properties. Click the Details Tab and the device instance path should display
rcbottom.

Right Click and select Update Driver Software....

Click Browse my computer for driver software.

Click Next.

Click Have Disk.

Click Browse, set the path to the Systems C: drive.

From the list, select the rcraid.inf entry.

Click Open.

. Click OK.

Click Next.

Note: If a Window Security Window pops up, select Install this driver software anyways.
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y. Click Close.
z. Click No at the System Settings Change pop up prompting the user to restart the
system.

3. Perform Step 4 for each addition NVMe you want to run RAID.
4. Expand Other Devices:
a. Select AMD-RAID Configuration SCSI Processor Device.
Right click and select Update Driver Software....
Click Browse my computer for driver software.
Click Let me pick from a list of available drivers on my computer.
Click Next.
Click Have Disk.
Click Browse, set the path to the Systems C: drive.
From the list, select the rccfg.inf entry
Click Open.
Click OK.
. Click Next.

AT T S@e@ o a0 o

Note: If a Window Security Window pops up, select Install this driver software anyways.

I. Click Close.
m. Click No at the System Settings Change pop up.
5. Restart the System.
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Chapter 6 AMD RAIDXpert2 Graphical User
Interface (GUI)

6.1 Start RAIDXpert2

The RAIDXpert2 graphical user interface (GUI) is a Desktop Application tool designed and
packaged to be a UWP compliant package, available from the Microsoft Store. It reads and writes
to the internal RAID drivers, which communicate with the AMD-RAID arrays and physical
devices. Also available, is a version that is based off the Desktop application but is not UWP
compliant.

Open the Windows menu and search for AMD RAIDXpert2 or the desktop shortcut.

6.1.1 Desktop Shortcut Access
6.1.1.1 Signing in Using the RAIDXpert2 Desktop Shortcut

Open the Windows menu and search for AMD RAIDXpert2, click to open or make a desktop
shortcut, or pin to the taskbar.

6.1.1.2 Help and About Windows

To view the software version and build number for the GUI, select About at the Help menu. The
AMD RAIDXpert2 Driver Version and GUI Version displays.

For AVA Reference Help, select Help > User Guide. A pdf version of this document will display.
A pdf reader program will be necessary to view it.

For further customer support, click Help > Support this will direct you to the AMD Drivers and
Support page, or contact your system supplier or motherboard vendor.

Chapter 6 AMD RAIDXpert2 Graphical User Interface (GUI) 77



AMDA

AMD-RAIDXpert2 User Guide 53987 Rev.3.11 June 2020

6.2 Reviewing the RAIDXpert2 GUI

6.2.1 The Array View Section of the Array Status Window

6.2.1.1 Elements of the Array View Section

The Array View section presents a graphical view of array properties. Table 17 provides
information about the elements of the Array View section (see Figure 2 on page 79).

Table 17. Elements of the Array View Section, Array Status Window

Element Description

Controller Name | The RAIDXpert2 controller for the arrays displayed below it.

Array The number assigned to an array.

Array name The name assigned to an array.

RAID Level The RAID level of the array.

Disk Number The number assigned to disks in an array.
Disk The manufacturer of disks in an array.
Manufacturer

Disk Model The model number of the disks in an array.
Number
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Figure 2. Array Status Window
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6.2.2 The Disk List Section of the Array Status Window
6.2.2.1 Elements of the Disk List Section

The Disk List section provides information about all disks assigned or available to arrays. Table
18 provides information about the elements of the Disk List section.

Table 18. Elements of the Disk List Section, Array Status Window

Element Description
Disk Controller and disk number.
State State of the disk (Online, Offline, SMART Error).
Type Disk type (Disk, Legacy, New).
Port Type Negotiated Speed (not the speed of the port type and SATA NCQ or NVMe
Capacity Disk capacity:

1 MB = 1,000,000 bytes

1 GB =1,000,000,000 bytes

Note: Because the ATA storage industry has standardized the meanings of
MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2
reports the same units

Space Available Total amount of space unused on the disk.
Largest Available Largest contiguous unused space on the disk.
GS Indicates if the disk is assigned as a global spare.
Users Number of arrays that this disk is a member of.
Model Disk manufacturer’s model number.

Serial No. Disk manufacturer’s serial number.

Firmware Disk manufacturer’s firmware version.
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If a disk is missing from the Disk List, the most likely cause is:

e A loose cable. Make sure that all disk cables are connected, then perform a rescan.

e Adisk that is not fully seated in its bay or slot. Make sure that the disk is inserted
completely in its bay or slot, then perform a rescan.

6.2.3 The Array List Section of the Array Status Window
6.2.3.1 Elements of the Array List Section

The Array List section provides information about the arrays. Table 19 provides information about
the elements of the Array List section.

Table 19. Elements of the Array List Section, Array Status Window

Element Description
Device The array number.
OS Name Corresponds to the Disk number in Windows Disk Management.
System If yes, it is your boot array, otherwise it is not a boot critical array.

Drive letter that was assigned to this array during the partition process. (A
blank space appears if the array has not been partitioned.)

Partition . .
Note: If a dynamic volume is created on an array, RAIDXpert2 cannot
retrieve the volume’s drive letter.
Array Name User-created name for the array.
Type The RAID level (RAID type) or LEGACY.

Total capacity:

1 MB = 1,000,000 bytes

1 GB =1,000,000,000 bytes

Note: Because the ATA storage industry has standardized the meanings of
MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2
reports the same units.

Total Capacity

State State of the array (NORMAL, CRITICAL, OFFLINE).

Task Task type, if in progress (TRANSFORM, CHECK, CHECK_BITMAP,
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Element Description

CREATE, RESTORE, ZERO, SECURE_ERASE).

The state of the task (STARTED, PAUSED, COMPLETED); the progress

Task State of the task is given in the Array View section.

Process Percent given of a given task.

Pri Task priority if a task is in progress.

Scan Background Array Scan enabled? (Yes/No).

Cache Current cache setting (NC = No Cache, R = Read Ahead Cache, W = Write

Back Cache, RW = Read/Write Cache).

Any Array with only HDD/SSD will have default CTS of 64k

Cache Tag size Any Array with NVMe/HDD/SSD will have default CTS of 256k

Dedicated Spare If assigned, the number of dedicated spares assigned to array.

6.2.4 The Event View Section of the Array Status Window
6.2.4.1 Elements of the Event View Section

The Event View section is an optional-view section. It can be displayed or hidden by selecting
View > Event View.

The information in the Event View is linked to the View Log. The View Log displays user-
initiated tasks or actions, and system-generated notifications and events. The View Log can be
accesses by selecting View > Log.

The Event View provides information about the events. Table 20, on page 82, provides
information about the elements of the Event View section.

Table 20. Elements of the Event View Section, Array Status Window

Element Description

# The number of the event.

Date The date and time at which the event occurred.

Event The RAIDXpert2 Asynchronous Event Notification (AEN) number of the event.
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Element Description

Priority | The notification priority of the event: Low, Informational, Warning, Critical, or Fatal.

Text A brief description of the event.

6.2.5 Array and Disk Commands

The Array and Disk menus of the Array Status window contain lists of commands. The commands
allow the system user to initiate or modify array- and disk-related tasks.

Not all commands are available for an array or for the system. Availability depends on:

e The tasks that can be performed with the system’s license level.

e The RAID level of an array. For example, a Consistency Check can be performed only on
arrays at a redundant RAID level.

e The remaining capacity of the disk drives. For example, if a system has three disk drives
and large arrays have used all of the capacity on two of the disks, only non-redundant
Volume arrays can be created on the remaining disk. Certain commands are not available
with a non-redundant array.

Table 21 provides page numbers for each command.

Table 21. Disk Menu Commands

Disk Commands See Detailed Information on this Page
Rescan page 83
Initialize page 84
Clear Metadata Page 84
Properties page 85
Options page 85

6.3 Working with Disks

6.3.1 Rescan Disks
The Rescan Command Performs the Following Actions:

e Rescans the SATA channels that search for new, legacy, or removed disks.
e Rereads the configuration information from each disk.

When a disk is offline, it might be brought online by using a rescan. A rescan also stops and then
automatically resumes all tasks.

Chapter 6 AMD RAIDXpert2 Graphical User Interface (GUI) 83



AMDA

AMD-RAIDXpert2 User Guide 53987 Rev.3.11 June 2020

To rescan disks, select Rescan at the Disk menu.

6.3.2 Initialize Disks

When a disk is initialized, RAIDXpert2 configuration information (metadata) is written to the
disks. If a disk is new and has not been used before, or if it is a legacy disk, it must be initialized
before it can be used in a RAIDXpert2 array. After a disk is initialized, it appears as Disk in the
Disk List.

If all the disks contain metadata, the Initialized button is deactivated (greyed out).

Note: All new disks and legacy disks will have an associated array. You must delete the array in
order to initialize the disk.

6.3.2.1 To Initialize Disks

1. Atthe Disk menu, select Initialize. The Initialize Disk window displays.
2. Select the disk(s) to be initialized, by selecting the box next to the disk(s).
3. Click Initialize Selected.

6.3.3 Clear Metadata Description

When a device has Clear Metadata applied to it, the RAIDXpert2 metadata is removed and the
device becomes a New/Legacy device.

If the device is part of an Array or is a New/Legacy device, it will not be available to be selected.
Also, if there aren’t any devices that are empty, the Clear Metadata button is deactivated (greyed
out). The device will no longer be useable in AMD-RAIDXpert2 until it is initialized.

6.3.3.1 To Clear Metadata Steps

1. Atthe Disk Menu, select Clear Metadata. The Clear Metadata window displays.
2. Select the device(s) to be initialized, by selecting the box next to the device(s).
3. Click Clear Metadata.

6.3.4 Change Cache Properties for Disks

The Read Ahead and Write Back Cache properties can be changed if the disks support this option.
The default settings are:

e Read Ahead: enabled.
e \Write Back Cache: enabled.

CAUTION: Leaving Write Back Cache enabled can increase the likelihood of data being
corrupted if the system experiences a power interruption or unexpected shutdown.
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Note: 4 disk’s cache setting cannot be changed if a task is active for the array. The cache settings
are enabled when the task is finished.

Note: As default setting NVMe Physical disk Read ahead and Write Back cache is always
disabled. User cannot enable the setting as it may impact the operational performance of
the NVMe disk.

6.3.4.1 Change Disk Caching Properties

At the Disk menu, select Properties.

The Properties window opens.

Select the disks you want to change the properties of.
4. Click Enable or Disable for the desired settings.

Note: Each time Enable or Disable is clicked, the disk selection clears. To change multiple
settings on one disk, select the disk before clicking each setting.

w e

6.3.5 Options

Spare disks allow an array to be rebuilt when a disk fails. Global spares can be used in any array,
while dedicated spares are assigned to a specific array.

6.3.5.1 Assign a Disk as a Dedicated or Global Spare

1. Select a disk in the Disk List section.
2. Select Options at the Disk menu. Options for Disk Device displays in the Disk List panel.
3. Perform one of the following actions:

e To use the disk as a dedicated spare, select Assign as Dedicated Spare.

Note: The capacity of a dedicated spare must be equal to or larger than the capacity of the
smallest disk in the array.

e Select Assign as Global Spare to use the disk as a global spare.
4. Click Confirm.

6.4 Working with Arrays

6.4.1 Create and Format Arrays

RAIDXpert2 allows the partitioning and creation of as many as eight arrays across the system’s
disks. Portions of disks can be used to create arrays, while other arrays use different portions of
the same disks.
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Array Commands

See Detailed Information on this Page

Create page 87
Name page 88
Transform page 88
Check Consistency page 95
Background Array Scan page 96
Modify Cache Settings page 94
Task page 94
Name page 88
Hide page 97
Identify Array page 81
Prepare to Remove page 97
Remove Spares page 97
Delete page 93
Delete Multiple Arrays page 93
Secure Erase page 98

6.4.1.1 Before You Begin...

Review the issues and recommendations indicated in Table 23.

Table 23. Creating Arrays: Issues and Recommendations

Issues

Recommendations

Access to arrays

process).

The creation of arrays, even redundant arrays, allows users immediate
access to the arrays (unless the Zero Create option is used during the Create

Array numbers

Array numbers are valid only for a given boot and can be different in the
BIOS Configuration Utility and RAIDXpert2. If a permanent label is
required, use the Array Naming feature described in Section 6.4.2, Name
Arrays, on page 88.

Array size The array size of the new array is limited to 2.199 TB on some versions of
Windows and Linux. Refer to the operating system documentation for
details on maximum array sizes.
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Issues Recommendations
Number of arrays In some circumstances, more than eight arrays are possible. They might

appear to function properly but are not supported by AMD-RAID.

System reboot When the system reboots, the creation process continues where it left off.

6.4.1.2 Create an Array

6.4.1.2.1 Select an Array and Cache
1. Select Create at the Array menu.

2. Select the disk(s) to include in the array by checking the box next to the desired disk(s) in
the Select Active Disks: field.

Note: Click All to select all disks, or click Unused to select disks that are not currently used in an
array. Maximum of 8 NVMe/HDD/SSD disks can be part of array. if more than 8 disks,
the Create button will be grayed out or unselectable.

3. Enter a name for the array in the Array Name: field.
Note: The following characters are not allowed in an array name

( ) N , | = & 2

4. Select an array type at the Array Type: drop-down menu.
5. Select an option at the Organized As: drop-down menu.

Note: The Organized As: drop-down menu only displays options for advanced management of a
RAID10 configuration if you selected RAID10.

6. Enter the capacity in the Capacity: field. The maximum available capacity changes with:
e The disks that are selected.
e The RAID level of the array.

7. Select a cache option at the Cache Options: drop-down menu. (The default is Read and
Write Back Cache.)

8. Cache Tag Size will default to a setting based off of the disks that are selected. All
HDD/SSD, default will be 64k. All NVMe or a mix of NVMe/HDD/SSD will default to
256k. The user should not change from the default settings.

9. Check Background Array Scan to enable background array scanning. (A background
array scan checks the sectors of the disks in an array for potential problems. A background
array scan runs continuously, until the user stops it by accessing Array > Background
Array Scan > Stop).

Note: Please refer to Table 16 on page 43 for Default Cache Tag Size.
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Note: See Section 6.4.11, Scan an Array in the Background, on page 96, for details.

10. Check Skip Initialize to skip initialization.

CAUTION: Creating a redundant array with Skip Initialization selected can result in data
corruption.

11. Check Leave Existing Data Intact if an array is lost or deleted, and the user immediately
creates a replacement array of the same characteristics. This leaves the data on the disks of
the lost or deleted array untouched when the replacement array is created. See Table 40, on
page 123, for additional information.

12. Check Zero Create to write zeros on the created array. If Zero Create is used, the array is
not immediately available (the array is hidden from the operating system during the Create
process).

13. Click Create to create the array.

6.4.1.3 Partition and Format an Array

Each operating system has different names and paths for partitioning and formatting arrays and as
such are outside the scope of this document. For more information, see your operating system’s
user documentation.

6.4.2 Name Arrays

Naming an array can be useful when creating backups. It makes an array easy to identify in a list
of arrays.

1. Inthe Array View section, select the array to name.
2. Atthe Array menu, select Name. The Array Name window displays.
3. Type the desired name in the blank field.

Note: The following characters are not allowed in an array name:

( ) N , | = & ”

4. Click OK. The array name appears in the Array List and in the BIOS Configuration Utility
(only 17 characters of the name are displayed in the BIOS Configuration Utility).

6.4.3 Transform Arrays
With the Transform task, an array can be:

e Transformed from one RAID level to almost any other RAID level. This function is also
referred to as Online RAID Level Migration (ORLM).
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e Expanded dynamically, even under 1/O load, by adding disks to the array to increase the
capacity of the array. This function is also referred to as Online Capacity Expansion
(OCE).

6.4.3.1 Before You Begin
Review the issues and recommendations indicated in Table 24.

Table 24. Transforming Arrays: Issues and Recommendations

Issues Recommendations

Array size An array cannot be transformed to a smaller-sized array. The transformed
array must be the same size as or larger than the original array.

Array size limits The array size of the transformed array is limited to 2.199 TB on some
versions of the Windows and Linux operating systems. Refer to the
operating system documentation for details on maximum array sizes.

Disk failure during a | If a disk fails while the Transform task is in progress, no data is lost if the
Transform source and destination RAID levels are redundant. If a spare has been
assigned to the destination array, a fail-over task starts as soon as the
Transform completes (if the spare is available after the Transform).

Multiple arrays If there are multiple arrays, it might not be possible to transform some of the
arrays to a larger size. If, in the future, an array needs to be expanded in
size, it is best to configure the available space as a single array.
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Table 24. Transforming Arrays: Issues and Recommendations (Continued)

Issues Recommendations
Task control When using task control commands, a Transform task can only be paused or
commands resumed but not removed. To end a Transform task, pause and delete it.

Note: If a task is paused and then deleted, the array is deleted. Deleting a
task is the same as deleting an array. Data loss occurs when a task is
deleted. Please ensure that data is backed up prior to deleting a task
involving a Transform or a Restore.

System reboot If the system reboots during a Transform, the Transform continues where it
during a Transform | left off.

6.4.3.2 Transform an Array

1. Inthe Array View section, select the array to transform.
2. Atthe Array menu, select Transform.
Note: If the system window is not wide enough, only the Destination View is displayed.

3. Select all the desired disks for the array (including disks that might be already in the array)
by selecting the box next to the drive in the Disk List section.

Note: Click Same to select all disks currently used in the array, All to select all disks, or
Unused to select disks that are not currently used in an array.

4. Select the RAID level to be transformed at the Array Type: drop-down menu.
5. Select an option at the Organized As: drop-down menu.

Note: The Organized As: drop-down menu only displays options for advanced management
of a RAID10 configuration if you selected RAID10.

6. Expand the array by entering the size of the new array in the Capacity: field. The
maximum available capacity changes with:

e The disks that are selected.
e The RAID level of the array.

Note: If a Transform is not possible, the Commit option is not enabled. A typical reason
preventing a Transform is insufficient available space on the disks.

7. Click Commit.

Note: Unless the transformation is instantaneous, the Array Status window updates to show
the source and destination arrays, along with the progress of the transformation.
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6.4.3.3 Access Additional Space

After an array has been transformed to a larger size, use the operating system tools to access the
additional space.

There are several possible methods for expanding the existing file system on an array that has been
transformed to a larger size:

e Microsoft provides a command prompt utility called Diskpart.exe that can expand any
NTFS file system without requiring a reboot. The Diskpart.exe utility version to use
depends on the version of Windows being run. The Diskpart.exe utility can be found on
the CD that comes with some versions of Windows, or at the Microsoft website
(http://www.microsoft.com) for others. Use the correct version for the operating system.

e For arrays formatted with FAT32, use a third-party application, such as PartitionMagic
from PowerQuest Corporation.

6.4.4 Restore (Rebuild) Arrays

With the Restore task, a redundant-type array whose state has changed to Critical can be restored
(rebuilt) in one of two ways:

e By assigning a dedicated spare to the array.

e By creating a global spare or by using an existing global spare. (An existing global spare
automatically starts restoring a redundant-type array after the array’s state changes to
Critical.)

An array in an Offline state cannot be restored. This means that non-redundant arrays (Volume,
RAIDO) cannot be restored: when a single disk in a non-redundant array fails, the array state
changes to Offline.

Note: If a Critical redundant array that is being restored loses a second disk (RAID1), or loses a
second disk in the same mirror set (RAID10), the Restore task fails. The array must be re-
created from backup storage data.

6.4.4.1 Before You Begin

e Make sure that the disk chosen as the dedicated spare or global spare has sufficient
available capacity to restore the array. The capacity of the spare disk must be equal to or
larger than the capacity of the smallest disk in the critical array.

e Know how to create a global or dedicated spare. See Section 6.4.12, Add or Remove
Dedicated Spares, on page 97 or Section 6.4.13, Add or Remove Global Spares, on page
97.

6.4.4.2 Restore a Critical Array

1. Inthe Array View section, select the critical array.
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2. At the Disk List section, double click on a disk.

3. At the Disk menu, select Options. Options for Disk Device displays in the Disk List
panel.

4. Perform one of the following actions:
e To use the disk as a dedicated spare, select Assign as Dedicated Spare.
e To use the disk as a global spare, select Assign as Global Spare.

5. Click Confirm.

6.4.5 Prepare to Physically Remove an Array
6.4.5.1 Physically Remove an Array

CAUTION: Prior to removing an array, remove its drive letter (Windows) or unmount the array
(Linux).

1. Select the array to remove in the Array View section.
Select Prepare to Remove at the Array menu.

Click Yes at the Prepare to Remove window. The array and all associated disks disappear
from the Array Status window.

4. Remove the first disk from the system.

5. Click Cancel when the Drive Removed window displays.
6. Remove the remaining disks in the array.
5
5.

w ™

. When all disks in the array are removed from the system, select Rescan at the Disk menu.

6.4.5.2 Array Migration

The disks in an array, after being removed from one system with a RAIDXpert2 controller, can be
migrated to another system with a RAIDXpert2 controller. The disks and array(s) appear in the
second system, in Disk Management, the BIOS Configuration Utility, and RAIDXpert2, as normal
RAIDXpert2 disks and array(s).

If the disks from a RAIDXpert2 system are migrated to a non-RAIDXpert2 Windows-based
system, the disks appear in Disk Management of the second system as healthy, unknown
partitions. To use the disks, use Disk Management to delete the RAIDXpert2-created partitions
and to create Windows partitions on the disks.

CAUTION: All data contained in a RAIDXpert2 array are lost if the RAIDXpert2 disks of the
array are migrated to a non-RAIDXpert2 system.
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6.4.6 Delete Arrays

CAUTION: Deleting an array permanently destroys all data that is on the array. This action
cannot be undone, and it is very unlikely the data can be recovered.

6.4.6.1 Before You Begin
Review the issues and recommendations indicated in Table 25.

Table 25. Deleting Arrays: Issues and Recommendations

Issue Recommendation
Drive letters or Remove drive letters or partitions from the array using procedures in your
partitions operating system. Each operating system has different names and paths for

removing drive letters or partitions and as such are outside the scope of this
document. For more information, see your operating system’s user
documentation.

Operating system If the array is not being used by the operating system, the array can be
impact on arrays deleted at any time, even while tasks are running on the array.

If the array is being used by the operating system, the array cannot be
deleted. Therefore, a RAIDXpert2 bootable array cannot be deleted in
RAIDXpert2. A RAIDXpert2 bootable array can only be deleted in the
BIOS Configuration Utility.

6.4.6.2 Delete an Array

1. Inthe Array Status window, select the array to delete.
2. Atthe Array menu, select Delete. A window opens, warning about deleting the array.
3. Click Yes. The array disappears from the Array View section.

Note: Also see Section 7.5, Delete Arrays: rcadm --delete, on page 107.

6.4.6.3 Delete Multiple Arrays

Select Delete Multiple Arrays at the Array menu.

Select (check mark) the arrays you want to delete. The Select All button can also be used.

1
2.
3. Click the Delete Button. A window opens, warning about deleting the array(s).
4. Click Yes. The array(s) will disappear from the Array View Section.

6.

6.4.6.4 Recreate a Deleted Array

If an array is deleted, it might be possible to recreate the array. See Table 40. Recreate a Deleted

Array, on page 123.
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6.4.7 Cache Settings for Arrays
Table 26 provides information about the four array-caching options available.

Table 26. Cache Array Options

Option Description

No Cache I/0 requests are translated and passed to the disks without keeping a cached
copy of the data available for future requests

Read Cache Data reads are cached, if appropriate. This option performs sequential Read
Ahead, when necessary

Write Back Cache Data writes are cached. This setting is intended for advanced users who
understand the implications of Write Back caching

Read + Write Back Both Read and Write Back Cache options can be selected
Cache (default
setting)

Note: Cache options cannot be changed while a task is active on the array. They can be changed
at any other time, including while 1/0 is running.

6.4.7.1 Change Cache Settings

1. Select the array on which to change caching options in the Array View section.
2. Select Modify Cache Settings at the Array menu.

3. Choose No Cache, Read Cache, Write Back Cache, or Read + Write Back Cache. The
new cache setting displays in the Array List Cache information.

6.4.8 Change the Priority Level of a Task

The task priority command allows the user to speed up or slow down tasks being performed on
arrays.

To decrease the amount of time it takes for a task to complete, set the task priority higher (10 is
the highest).

Note: A task priority can only be changed after a task is running on the array.
6.4.8.1 Change a Task Priority

1. Select the array on which tasks are being performed in the Array View section.
2. Select Task and select Priority at the Array menu.
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3. At the Task Priority window, change the task priority by moving the slide one way or the
other.

4. Click OK.
6.4.9 Interrupt, Cancel, or Resume a Task

The task control commands allow the user to pause, resume, or cancel (remove) tasks being
performed on arrays.

Full task control can be used on Create, Consistency Check, and Check Bitmap tasks. On Restores
with dedicated or global spares the task can be removed, but the array returns to the Critical state.

Note: Task control can be used only when a task is running on an array.
6.4.9.1 Interrupt, Cancel, or Resume a Task

1. Inthe Array View section, select the array on which a task is being performed.
2. Atthe Array menu, click Task and select one of the following:

e Pause to interrupt the task.

e Remove to cancel the task.

e Resume to interrupt the task.

6.4.10 Check for Consistency

For redundant-type arrays only, the Consistency Check task is available at the Array menu. When
this task is selected it starts the process of verifying that the mirror drive consistency for fault-
tolerant disks is correct. If inconsistent areas are found, they are corrected during this process.

Having consistent arrays is very important. If an array is inconsistent and a drive fails, data is lost.
RAIDXpert2 is designed to maintain consistent arrays, but it is good practice to run frequent
consistency checks.

When a redundant array is created using the Create command, and the Skip Initialize option is not
checked (the default setting), a Consistency Check is performed automatically. Although a
Consistency Check that runs during a Create task can be removed (by highlighting the array and
selecting Task > Remove), the array that is created is not redundant. Unless a Consistency Check
runs from end-to-end, an array is not protected.

After a Consistency Check has been started, adjust the priority of the Consistency Check task
relative to user 1/O activity. Use the Task Priority option (see Section 6.4.8, Change the Priority
Level of a Task, on page 94).
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6.4.10.1  Before you Begin

e The Consistency Check command can be started at any time on a redundant-type array, as
long as another task is not running on the array.

e The Consistency Check command can be started while under 1/O load.
e |f the array state is Critical, the Consistency Check fails.

e To estimate the remaining time for a Consistency Check, look at the percentage of the task
that is completed (in hours: minutes: seconds). These details are displayed next to the
array in the Array View section of the Array Status window.

6.4.10.2  Manually start a Consistency Check

1. Select the array on which to run the Consistency Check in the Array View section.
2. Select Check Consistency at the Array menu.
3. Click Start.

6.4.10.3  Manually stop a Consistency Check

1. Select the array on which to stop the Consistency Check in the Array View section.
2. Select Check Consistency at the Array menu.
3. Click Stop.

6.4.11 Scan an Array in the Background

A Background Array Scan task performs a continuous background read operation of an array,
accessing at least one copy of every block of the array from beginning to end.

A Background Array Scan is manually started by the user and runs continuously until the user
stops it.

Although a Background Array Scan can run while an array is engaged in other tasks, it is
recommended that the Background Array Scan run while the array is idle (that is, when there is no
I/O to or from the array).

6.4.11.1 Enable or Disable a Background Array Scan

1. Select the array to on which to run the Background Array Scan in the Array View
section.

2. Select Background Array Scan at the Array menu.
3. Enable or disable the Background Array Scan.
e Select Start to enable a Background Array Scan.
e Select Stop to disable a Background Array Scan.
Note: A Background Array Scan can also be enabled for an array when it is created.
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6.4.12 Add or Remove Dedicated Spares
If a dedicated spare is added, make sure there is adequate space on the dedicated spare.
6.4.12.1  Add a Dedicated Spare

1. Select the array on which to assign a dedicated spare in the Array View section.
2. Double-click on the disk chosen as the dedicated spare in the Disk List section.
3. Select Options at the Disk menu.

4. Select Assign as Dedicated Spare, then click Confirm.

6.4.12.2 Remove a Dedicated Spare Assignment

1. Select the array from which to remove a dedicated spare in the Array View section.
2. Select Options at the Disk menu.
3. Select Remove as Dedicated Spare, then click Confirm.
TIP: For additional information see Section 2.10, Sparing Options: Disks and Arrays, on page 32.

6.4.13 Add or Remove Global Spares
If a global spare is being added, make sure there is adequate space on the global spare.
6.4.13.1 Add a Global Spare

1. Select the disk chosen as the global spare in the Disk List section.
2. Select Options at the Disk menu.
3. Select Assign as Global Spare, then click Confirm.

6.4.13.2 Remove a Global Spare

1. Select the disk to be removed as the global spare in the Disk List section.
2. Select Options at the Disk menu.
3. Select Remove as Global Spare, then click Confirm.

6.4.14 Hide an Array
Hide allows the user to hide the array from the operating system.
6.4.14.1 Hide an Array

1. Select the array to hide in the Array View section.
2. Select Hide at the Array menu. The array will disappear from the Array View.
Note: If the array is currently hidden, select Array > Un-hide to display it.
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6.4.15 Secure Erase

Secure Erase is used for erasing all data on an array and ensuring that it will be unrecoverable,
even with advanced data recovery techniques.

Data is Securely Erased By:

e Hiding the array from the OS
e Writing over each region of the disk with 3 patterns (0OXxAA, 0x55, and random)
e Using a 4th pass with all zeros to ensure that a RAID1 will be consistent

After the secure erase is complete, a user can choose to manually delete the array or reuse it. If the
user chooses to reuse it, it must be unhidden using the procedure in Section 6.4.14, Hide an Array,
on page 97.

CAUTION: When an array is securely erased, the data on the array is lost.
6.4.15.1  Securely Erasing an Array

1. Select the array to erase in the Array View section.
2. Select Secure Erase at the Array menu, then click OK.

6.5 Working with Views

The View menu allows the user to:

e Refresh the display

e Display the event view

e Display the Application log

e View Controllers

e Theme — Dark, light

e Icon Size — Small, Large

e Font Size — Small, Normal, Large

6.5.1 Display or Hide Controller Event Log Panel

To display or hide the Controller Event Log, select Event View at the View menu. When the
Controller Event Log panel displays, a checkmark appears next to the Event View option at the
View menu.

6.5.2 Log Window

The [system name]: View Log window displays all the messages generated by RAIDXpert2. All
messages are logged, not just the ones enabled at Options > Notification.
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All messages received from the RAIDXpert2 driver are sent to a message log file. If desired,
change the name of this file in the Notification window.

By default, notification events in Windows-based systems are saved to:
%Program Files%\RAIDXpert2\rc_service.log.
Notification events in Linux-based systems are saved to /var/log/rc_service.log.

Select Log to view the RAIDXpert2 messages at the View menu.

6.5.3 Refresh the Display

Select Refresh at the View menu to refresh the display.
6.5.4 View Controllers

1. Select View Controllers in the View menu. A window displays listing the Controller List
of system.

Note: The list will include the Controller Number, Type, Serial Number, Port Count, PCI
Vendor ID, PCI Device ID, PCI SubVendor ID, PCI SubDevice ID.

2. Click OK to close the window.

6.6 Working with Options

6.6.1 Event Notifications

The Event View section of the Array Status window displays the priority listing. The event log
priority levels, in ascending order, are indicated in Table 27.

Table 27. Event Log Priority Levels

Event Priority Description

Low Displays messages for normal system operations. (This event is not
displayed unless requested by the user.)

Informational Displays information that might be useful to know.

Warning The system user should be informed about this event, but probably does not
need to take action.

Critical The system user must be informed about this event and should take action.
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Fatal

The RAIDXpert2 driver is fatally damaged and the RAID subsystem has
shut down.

6.7

Add Spares Using a RAIDABLE Array

Note: RAIDABLE array is formerly known as RAID Ready array.

1. Install a new disk. After a rescan, a pop-up window opens.

Note: To create a redundant RAID1 array, the new disk must be the same size or greater than
the RAIDABLE disk.

2. Select the new disk in the Select a Disk section.
3. Select the desired option in the Choose a Task section.
Note: Selecting any option first initializes the disk before the selected task is started.

a.

d.

Backup Array: This option creates a backup of the RAIDABLE array on the new
disk.

Transform Array: This option allows the user to either add space to the RAIDABLE
array or create a redundant array.

Initialize Disk for AMD-RAID: This option allows the disk to be used when creating
arrays.

Make disk a Global Spare: This option assigns the new disk as a global spare.

4. In the Select a Source/Destination section:
a. Select the Source RAIDABLE Array from the drop-down menu.
b. Select the Destination Array Type from the drop-down menu.
Note: The Destination Array Type option is only available when either the Backup Array

task or Transform Array task is selected. Only valid array types for the number of
disks inserted will be displayed. For example, if one new disk is inserted, only RAIDO
or RAID1 will display in the drop-down menu.

5. Click Confirm.

If either the Backup Array task or Transform Array task is selected, a Task Progress dialog
box opens. To hide the dialog box while the task is executing, click Close.
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Chapter 7 rcadm Command Line Interface
Tool

7.1 What is rcadm?

The rcadm program is a command line interface (CLI) tool for managing RAIDXpert2 in the
Windows, Linux, or EFI operating system. See Section 7.8, on page 108, for rcadm.efi
Information.

The rcadm program initiates RAIDXpert2 operations, such as:

e Manage RAIDXpert2, arrays and disks (see Section 7.2, Manage Arrays and Disks: rcadm
--manage, on page 102).

e Create new arrays (see Section 7.4, Create New Arrays: rcadm --create, on page 106).
o Delete arrays (see Section 7.5, Delete Arrays: rcadm --delete, on page 107).
e Transform arrays (see Section 7.6, Transform Arrays: rcadm --transform , on page 108).

e Follow or monitor arrays and disks (see Section 7.7, Follow or Monitor Arrays and Disks:
rcadm --follow, on page 108).

e Information on drive and array states.

The rcadm program has five primary modes, with most primary modes having additional optional
arguments. The five modes of operation are indicated in Table 39.

Table 28. Modes for the rcadm Program

Mode Usage

Manage Uses the rcadm --manage command to manage and query RAIDXpert2,
arrays, and disks.

Create Uses the rcadm --create command to create a new array.

Delete Uses the rcadm --delete command to delete arrays.

Transform |Usesthe rcadm --transform command to transform an array.

Follow Usesthe rcadm --follow command to follow or monitor arrays and disks.

Follow these instructions to issue the command on the operating system. Also, see Section 7.3,
View Help from the Command Line, on page 106.
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7.1.1 To Use rcadm with a Linux® Operating System
By default, rcadm is installed in /usr/bin.
7.1.2 To Use rcadm with a Windows® Operating System

e Change directoriesto C: \Program Files (x86)\RAIDXpert2.
e Runthe rcadm.exe command from there.

or
e AddC:\Program Files (x86)\RAIDXpert2 to the system or user path
environment variables.

7.2 Manage Arrays and Disks: rcadm --manage

The rcadm --manageor rcadm -M command allows the user to view information about
RAIDXpert2 and manage the arrays and disks.

For example, the user can:

e Set cache attributes for arrays.

e Set priority levels for tasks on an array.
e Hide and unhide arrays.

e Listarrays.

e Initialize disks.

e Query information about disks.

e Add and remove spares from an array.
e Set cache attributes for disks.

7.2.1 Understand Query Output

When the rcadm --manage --query-all or rcadm -M -ga command is used,
information about the disks and arrays for the system is displayed.

To see information about a specific controller, disk, or array use the rcadm --manage --
query command, in conjunction with the appropriate options.
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Table 29. rcadm Controller List Elements

Element

Description

Number

Controller number assigned by RAIDXpert2

Type

Model number of the controller

Serial Number

Serial number of the controller

Port Count

The number of ports supported by RAIDXpert2

PCle® Vendor ID

The PCle vendor identification number

PCle Device ID

The PCle device identification number

PCle SubVendor ID

The PCle sub-vendor identification number

PCle SubDevice ID

The PCle sub-device identification number

SAS Address (WWID)

The SAS Address (world-wide identification number)

BIOS Version

The version of the AMD-RAID Configuration BIOS
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723 rcadm Disk List Elements

Table 30. rcadm Disk List Elements

Element Description
Disk Disk number assigned by RAIDXpert2, corresponding to the SATA
channel ID.
State State of the disk (Online, Failed, Unknown)
Disk Type Disk type (Disk, Legacy, New, ATAPI)
Port Type Port type (SATA, SATA Il, SATA IlI, SSD, NVMe)
Port Speed The negotiated speed of the port
Note: For NVMe the port type is always N/A.
Size Total size of the disk:
e 1MB =1,000,000 bytes
e 1GB =1,000,000,000 bytes
Note: Because the ATA storage industry has standardized the meanings of
MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2
reports the same units.
Free Space Total amount of space unused on the disk

Largest Free Space

Largest contiguous unused space on the disk

GS Indicates if the disk is assigned as a global spare

Ca Current disk cache setting (NC = No Cache, R = Read Cache, W = Write
Back Cache, RW = Read + Write Back Cache).
Note: For NVMe the CA is always NC.

Ctrl Chan Disk controller and channel number.

Vendor Disk vendor

Model Number

Disk model number

Firmware Version

Disk firmware version

Serial Number

Disk serial number
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Table 31. rcadm Array List Elements

Element Description
A Array number assigned by RAIDXpert2.
Type RAID type.
0O.S. Name Name assigned by the operating system to the array. The name shows as

“Hidden” if the array is hidden from the operating system. The name
shows “??” if the array is Offline.

Sys or System Device

Indicates whether or not the array is being used as a system disk under
Windows.

State

State of the array (Normal, Critical, Offline).

Size or Capacity

Total size of the disk:
e 1 MB =1,000,000 bytes
¢ 1GB=1,000,000,000 bytes

Note: Because the ATA storage industry has standardized the meanings of
MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2
reports the same units.

Hide Whether the array is hidden from the operating system.

Id Globally unigue identifier for the array assigned by RAIDXpert2.

Task Task type (Transform, Check, Check_Bitmap, Not_Active, Create,
Restore)
Note: See Section 2.7, Array Tasks: Starting and Stopping Tasks, on page

28 for detailed definitions.

Task State The state of the task (Started, Paused, Completed)

% The progress of a current array task, such as a Create or Transform, shown
as percent complete

CA Current array cache setting (NC=No Cache, R=Read Cache, Ww=Write Back

Cache, RW=Read + Write Back Cache).
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Table 31. rcadm Array List Elements (Continued)

Element Description

CTS Cache tag size specifies the amount of data per disk in a stripe. Supported
sizes are 64kB, 128kB or 256kB

Any Array with only HDD/SSD will have default CTS of 64k
Any Array with NVMe/HDD/SSD will have default CTS of 256k

Scan Background scan enabled (Yes/No)
Name User-supplied name for the array
Dedicated Spare Indicates the number of dedicated spares assigned to the array

(--verbose mode only)

Disk Listing of disks that are part of the array
Used Capacity used of a specific disk
Offset Location on the disk where the array begins

7.3 View Help from the Command Line

7.3.1 To view a List of the Major Modes of Operation
Type: rcadm --helpoOr rcadm -7?

7.3.1.1 To View Help for a Specific Mode and its Options

Type: rcadm <mode> --help Or rcadm < mode> -7?

For example, typing rcadm --manage --helpor rcadm -M -2 displays help and
examples regarding that specific mode and its options.

7.3.1.2 To view the rcadm Man Page on a Linux® System

Type: man rcadm

7.4 Create New Arrays: rcadm --create

The rcadm --createor rcadm -C command allows new arrays to be created. As many as

eight arrays can be partitioned and created across all disks.
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Portions of disks can be used to create arrays, while other arrays are using different portions of the
same disks. A maximum of eight arrays can be created.

7.4.1 Before You Begin...

Creation of arrays, even redundant arrays, allows users immediate access to the arrays. If the
system reboots, the creation process continues where it left off.

CAUTION: In some circumstances, more than eight arrays are possible. They might appear to
function properly but are not supported.

Note: The array size of the new array is limited to 2.199 TB with some operating systems. Refer to
the operating system documentation for details on maximum array sizes.

Note: The ability to create RAID10 or RAIDABLE arrays may not be available on your system.
7.4.2 Example

To create a 1 GB RAID1 array using disk members 1, 2, and 3, type: rcadm -C -rl -d 1 2
-s 1000

To see more examples, type: rcadm -C -2

7.5 Delete Arrays: rcadm --delete
The rcadm --delete or rcadm -Dcommand allows the user to delete one or more arrays.

CAUTION: Deleting an array permanently destroys all data that is on the array. This action
cannot be undone and it is very unlikely the data can be recovered.

7.5.1 Before You Begin...

e If the operating system is using an array it cannot be deleted.

e Ifanarray is accidentally deleted, and the user wants to try and recover the data, create an
array using the same disks, same size, and same cache, and use the --leave-existing-data
option. This option writes new configuration information to the array while trying to use
the exact same disk space as before.

7.5.2 Example
To delete array 1, type: rcadm -D -a 1

To see more examples, type rcadm -D -?
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7.6 Transform Arrays: rcadm --transform

The rcadm --transform or rcadm -T command allows the user to transform (migrate) an

array from one RAID level to almost any other RAID level, and to expand the array dynamically,
even under 1/0O load.

7.6.1 Before You Begin...

e An array cannot be transformed to a smaller-sized array. New arrays must be either the
same capacity or larger.

e When using the task control option, a Transform can only be paused or resumed but not
removed.

e |f a spare has been assigned to the destination array, a fail-over task starts as soon as the
Transform completes, provided the spare is available after the Transform.

e If there are multiple arrays on a single controller, it might not be possible to transform
some of the arrays to a larger size. If the size of an array might be expanded in the future,
it is best to configure the available space as a single array.

e The array size of the transformed array is limited to 2.199 TB on some operating systems.

7.7 Follow or Monitor Arrays and Disks: rcadm --follow

The rcadm --followor rcadm -F command allows the user to follow or monitor arrays

and disks. It polls the RAID subsystem for any status changes and logs them in the Windows
System Event Log.

7.7.1 Before You Begin...
It is recommended that the user not run more than one instance of rcadm --follow at the same time.

If the user runs more than one instance of the command, each instance captures some of the
events, but no single instance captures all events.

7.8 rcadm.efi Information
7.8.1 rcadm -?
-?, ——help

Displays all primary rcadm commands, or if used after an option, displays help for that
specific option.

-log, --log-file
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Print output to a log file as well as standard output. Requires a log file name argument.
Overwrites existing file. Only one occurrence of this option on the command line is allowed.
Example: rcadm -M -ga -v -log status.txt

-C, -—--create

Command for creating arrays. Array types include linear (JBOD), volume (JBOD), RAIDO,
RAID1, RAID10, RAID10n, and RAIDABLE. Some of the major functions include assigning
spare disks; setting array size; and setting cache attributes.

-D, —--delete

Command for deleting arrays. This mode does not have any optional arguments.
-M, —--manage

Commands for managing and querying controllers, arrays, and disks. Some of the major
functions include querying for information, adding and removing dedicated and global spare
disks, setting cache attributes for arrays and disks, performing consistency checks on
redundant array types, initializing disks, prioritizing tasks for arrays, scanning arrays and disks
for changes in status, and hiding or unhiding arrays.

7.8.2 rcadm -M

MANAGE
-a, --array

Used with certain options to specify arrays.
-as, —--add-spare
Adds a dedicated spare disk to an array. No space is reserved on the disk selected.

-rs, ——remove-—spare

Removes a dedicated spare disk from an array.

-ras, -—--remove-all-spares

Removes any spares from an array.
-ags, -—--—add-global-spare

Adds a disk as a global spare. No space is reserved on the disk selected.
-rgs, -—--remove-global-spare

Removes a global spare disk.
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-ca, —--cache-array

Sets the cache attributes for an array. Cache attributes include read cache (r), read and write-
back cache (rw), write-back cache (w), and no cache (nc).

-cd, --cache-disk

Sets the cache attributes for a disk. Cache attributes include read cache (r), read and writeback
cache (rw), write-back cache (w), and no cache (nc).

-d, --disk

A required qualifier used with certain options to specify disks.
-h, --hide

Hides an array from the operating system.
-uh, --unhide

Unhides an array, making it visible to the operating system.
-id, --initialize-disk

Initializes a disk. If the disk is new and has not been used, you must initialize it before you can
create arrays.

-cm, --clear metadata

-n, —--name

Identifies an array with a user-supplied name. The name can be up to 30 characters, but only
17 of those characters display in the BIOS.

-p, —-priority
Sets an array's task priority from 1-10, with 10 being the highest priority.

-dq, —~query
Lists information about specific controllers, arrays, and disks.

-ga, —--query-all

Lists information about controllers, arrays, and disks.

-v, —--verbose

Modifier of the --query and --query-all option. Specifies more detail for arrays and disks.

-rsc, ——rescan
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Rescans the serial ATA (SATA) channels for new or removed disks.

-sa, —-scan-array <on|off>

Specifies if background array scan scanning is on or off.

-sp, —-smart-poll
Turns SMART polling on or off for the specified drive(s).

-t, —--task

Used to pause, resume, and remove tasks.

-ul, --unlink

Unlinks two arrays linked through a create copy operation.

SYNTAX and EXAMPLES
ADD SPARE
--add-spare --array <list> --disk <list>
-as —a <list> -d <list>
Examples: rcadm --manage --add-spare --array * --disk 1
rcadm -M -as -a 1 2 -d 5 6

REMOVE SPARE

--—remove-spare --array <list> --disk <list>
-rs -a <list> -d <list>

Examples: rcadm --manage --remove-spare --array 5 —--disk *

rcadm -M -rs -a * -d 5

REMOVE ALL SPARES

--remove-all-spares --array <list>
-ras -a <list>

Examples: rcadm --manage --remove-all-spares --array 5

rcadm -M -ras -a *

ADD GLOBAL SPARE

-—-add-global-spare —--disk <list>
-ags -d <list>

Examples: rcadm --manage --add-global-spare --disk 1 2 3

rcadm -M -ags -d *
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REMOVE GLOBAL SPARE

-—-remove-global-spare —--disk <list>
-rgs -d <list>

Examples: rcadm --manage --remove-global-spare --disk *
rcadm -M -rgs -d 5

CACHE SETTINGS FOR ARRAYS

—-—cache-array <cache attribute> --array <list>
—-ca <cache attribute> -a <list>
Cache attributes: <r> for read cache

<rw> for read and write-back cache
<w> for write-back cache
<nc> for no cache

Examples: rcadm --manage --cache-array rw --array *

rcadm -M -ca nc -a 1l

DISK SETTINGS (Advanced)
Disk cache:

—--cache-disk <cache attribute> --disk <list>
-cd <cache attribute> -d <list>

Cache attributes: <r> for read cache

<rw> for read and write-back cache
<w> for write-back cache
<nc> for no cache
Examples: rcadm --manage --cache-disk r --disk 1 2 3

rcadm -M -cd w -d *

HIDE ARRAY

--hide --array <list>
-h -a <list>
Examples: rcadm --manage --hide --array 5 6

rcadm -M -h -a 4

June 2020
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UNHIDE ARRAY

--unhide --array <list>
-uh -a <list>
Examples: rcadm --manage --unhide --array *

rcadm -M -uh -a b5

INITIALIZE DISK
-—initialize-disk --disk <list>
-id -d <list>
Examples: rcadm --manage --initialize-disk --disk *

rcadm -M -id -4 1 2 3

NAME ARRAY
--name "name" --array <list>
-n "name" -a <list>
Examples: rcadm --manage --name "System Disk" --array 5

rcadm -M -n "Backup Disk" -a 4

QUERY
-—query [—-—-array <list>] [--disk <list>]
[--verbose]
-g [-a <1list>] [-ct <list>] [-d <list>] [-V]

Examples: rcadm --manage --query --array 1 --disk --verbose
rcadm -M -g —a 1 2 3 -d -v

QUERY ALL

-—query-all
Example: rcadm --manage --query-all

RESCAN DISKS

--rescan
-rsc
Example: rcadm --manage --rescan
SCAN ARRAY
-—-scan-array <on|off> --array <array number>

-sa <on|off> -a <array number>
Example: rcadm -M --array 1 --scan-array on

rcadm -M -a 1 -sa off
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SMART POLL

--smart-poll <on|off> --disk <list>
-sp <onl|off> -d <list>
Example: rcadm --manage --smart-poll on --disk

rcadm -M -sp off -d 1 2 3

TASK CONTROL

-—-task <task operation> --array <array number>
-t <task operation> -a <array number>

Task Operation
<pause> to temporarily pause a task
<resume> to continue running a task
<remove> to permanently remove a task
Examples: rcadm --manage --task pause --array 5

rcadm -M -t remove -a 4

TASK PRIORITY

--priority <1..10> --array <list>
-p <1..10> -a <list>
Examples: rcadm --manage --priority 5 --array 6

rcadm -M -p 1 -a
UNLINK ARRAY

--unlink --array <array number>
-ul -a <array number>
Examples: rcadm --manage --unlink --array 2

rcadm -M -ul -a 5

7.8.3 rcadm -C

CREATE
Long form:
rcadm --create <raid type> --disk <list> [--size <size mb>]
[--sub-member <num>] [--spare-disk <list>]
[-—no-sync] [--d-spare] [--cache <r,rw,w,nc>]
[--max-size] [--name "name"] [--priority <1..10>]
[-—zero] [--scan-array]
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Short form:

rcadm -C <raid type> -d <list> [-s <size mb>] [-sub <num>]
[-sp <1list>] [-ns] [-ds] [-ca <r, rw, w, nc>] [-ms]
[-n "name"] [-p <1..10>] [-z] [-sal] }
RAID Types:

--volume, -v Single disk or concatenation of disks (JBOD)
--raidable, -ra Single disk, RAIDABLE

--raid0, -rO0 Stripe of two or more disks

--raidl, -rl Mirror of two disks

--raid5, -r5 Stripes data as well as parity, across all disks in the array
--raidl0, -r10 Stripe set of mirror sets

OPTIONS

-sp, —-spare-disk
Specifies the dedicated spare disk or disks to assign, with a maximum of four. No space is
reserved on the selected disks.

-s, —-size
Specifies the size of the array in MBs. If you do not use this option, the largest possible size is
used by default.

-ns, —--no-sync
Disables background synchronization of redundant types when creating the array.

-ca, --cache
Specifies a cache setting for the array(s): read cache <r>, read and write-back cache <rw>, write-
back cache <w>, or no cache <nc>. The default is read and write-back cache <rw>.

-cts, -—-cachetagsize
Specifies the Cache Tag Size. This is the amount of data per disk in a stripe. Supported sizes are
64, 128, or 256; sizes in kB.

Please refer to Table 16, Default Cache Tag Size, on page 43.

-ms, —--max-—-size
Prints the maximum possible size for an array without actually creating an array.

-n, -——-name
Identifies an array with a user-supplied name. The name can be up to 30 characters, but only 17 of
those characters display in the BIOS.

-p, —-priority

Chapter 7 rcadm Command Line Interface Tool 115



AMDA

AMD-RAIDXpert2 User Guide 53987 Rev.3.11 June 2020

Sets the background initialization task priority from 1 to 10, with 10 being the highest priority. For
redundant array types only.

-led, --leave-existing-data

Leaves the existing data on the disks untouched after the array is created. This option can be used
to try to recover user data when an array has been accidentally deleted or the configuration
information is lost but the data is still intact. Unless you immediately recreate the array after
deleting it and no other tasks have been performed, the likelihood of recovering data with this
method is very low.

-d, --disk
A required qualifier used with the --create option to specify the disk or disks to be included in the
array.

—-sSa, ——SCan—array
Specifies that a background array scan should be continuously run whenever the array is idle
(Default is off).

-z, ——ZzZero

Zero the array in the foreground. This method is faster than doing a background consistency
verifies if the array is a redundant type. For non-redundant types, the zero option can be used to
verify all blocks in the array can be accessed.

EXAMPLES
Example: Create a RAID1 set of the maximum possible size using all disks.
rcadm -C -raidl --disk *

Example: Create a RAID1 set of the maximum possible size, with a spare disk and without a
background initialization task.

rcadm -C --raidl --spare-disk 3 --disk 1 2 --no-sync
7.8.4 rcadm -D

DELETE
Long form:

-—-delete --array <list> [--no-ask]

Short form:

-D -a <list> [-na] [-cg <group number>]
OPTIONS
-na, --no-ask

If the no ask option is specified the array is deleted without confirmation.
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EXAMPLES:
Example: Delete arrays 1 and 2.

rcadm -D --array 1 2

Example: Delete all arrays.

rcadm -D --array
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Troubleshooting

8.1

Troubleshooting

The chapter discusses four major categories of troubleshooting:

8.2

Problems with system startup.
Warning messages that might appear at the Power-On Self-Test (POST) screen.

Problems with arrays.
Problems with disks.

Template for adding the warning message when someone tries to create a RAID5 on a
system that isn’t supported.

System Startup Problems

Table 32 and Table 33 correlate possible startup issues and corrective actions for system boot.

Table 32. The System Does Not Boot

Possible Causes

Corrective Actions

Controller mode is set
incorrectly during system
startup

In the system’s BIOS screen, ensure SATA settings are in RAID
mode.

The system’s boot mode
or boot sequence retry
mode is set incorrectly

In the system’s BIOS screen, ensure that the bootable array is the first
array listed.
Swap arrays is not supported in UEFI.

A bootable array is in an
Offline state

Restart the system.

Enter the system’s BIOS screen.
Check the state of the bootable array.
Check for missing or offline disks.
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Table 33. The BIOS Confi

guration Utility Does Not Display

AMD-RAIDXpert2 User Guide

Possible Causes

Corrective Actions

The controller mode is set
incorrectly in the system
BIOS

In the system’s BIOS screen, ensure the SATA settings are correct.

Possible Causes

Native AHCI installation.

Corrective Actions

the BIOS settings to RAID mode.

A Native AHCI installation will not boot into the OS, after changing

8.3

The POST screen is one of the first screens to appear during the system’s boot sequence. If the

Warning Messages: POST Screen

system’s arrays were in Normal or Ready state prior to a system boot, the boot sequence
continues normally to the operating system.

But, if an array is in Critical or Offline state, or if specific options at Controller Options were
changed previously at the BIOS Configuration Utility, the warning messages displayed by OProm

are described in Table 34 appear during the boot sequence.

Table 34. POST Screen Warning Messages

Warning Message

Additional Information

Corrective Action

WARNING: Found arrays
that are Critical
[or equivalent]

This warning message appears when at
least one array is in a Critical state and
Toggle Pause if Critical is set to ON at
the BIOS Configuration Utility.

The Critical state of an array depends on
the RAID level of the array and the
number of disks that have failed. See
Section 2.3, Array States, on page 25, for
information on criticality.

If an array is Critical (even a bootable
array), the system can continue through
the boot process to the operating system.

See Section 8.5.1,
Troubleshooting Disks, on
page 124.
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Warning Message

Additional Information

Corrective Action

WARNING: Found
arrays that are Offline

[or equivalent]

WARNING: Found
arrays that are Critical
and Offline

[or equivalent]

This warning message appears when at
least one array is in an Offline state and
Toggle Pause if Offline is set to ON at
the BIOS Configuration Utility.

If two or more disks in a redundant array
have failed, or if a single or multiple disk
in a non-redundant array have failed,
data has been lost.

In RAID10 array, if a single disk fails in
each mirrored set, the redundant array
goes to a Critical state but data is not
lost. If two disks fail in one of the
mirrored sets, the redundant array goes to
an Offline state and data is lost.

A bootable array that is in an Offline
state prevents the operating system from
booting.

See Section 8.5.1, Troubleshooting
Disks, on page 124.

If, after performing a rescan, the state
remains Offline, the bootable array has
suffered an unrecoverable failure.
Create a new bootable array.

Reinstall the operating system and
drivers.

BIOS NOT INSTALLED -
User Disabled INT13
BIOS Load

[or equivalent]

This warning message appears when
Toggle INT13 Boot Support option has
been set to OFF at the BIOS
Configuration Utility and another boot
device is not selected.

Bootable devices do not function with
the controller when Toggle INT13 Boot
Support is set to OFF. The default
setting is ON, which allows bootable
devices to function with the controller.

Restart the system.
Enter the system’s BIOS screen.

Select Main Menu > Controller
Options > Toggle INT13 Boot Support.

Change Toggle INT13 Boot Support
from OFF to ON.

Navigate to Main Menu.
Select Continue to Boot.

The system boot process continues to the
operating system.

8.4

Array-Related Errors

e Table 35. Cannot Create an Array, on page 121

e Table 37. An Array is in an Offline State, on page 122
e Table 36. An Array is in a Critical State, on page 122
e Table 38. Cannot Assign a Dedicated Spare to an Array, on page 122
e Table 39. Cannot Create a Global Spare, on page 123
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e Table 40. Recreate a Deleted Array, on page 123

Table 35. Cannot Create an Array

AMD-RAIDXpert2 User Guide

Possible Causes

Additional Information

Corrective Actions

The disk is not displayed.

The controller cannot communicate
with the disks.

See Section 8.5.1, Troubleshooting
Disks, on page 124.

Insufficient free space
available on the selected
disks

Select a different combination of
disks.

Incorrect number of
disks selected for the
desired RAID level

See 2.2, RAID Levels, on page 24,
for a description of RAID levels and
the allowable number of disks used
with each RAID level.

Select the correct number of disks.

The desired disk is
unavailable.

The disk is a dedicated spare for a
different array.
The disk is full.

The disk’s available capacity is
insufficient.

Select a different disk.

The disk has SMART
errors.

An array can be created with a disk
that has SMART errors, but only if
the array is created in the BIOS
Configuration Utility.
RAIDXpert2 cannot be used to
create an array with a disk that has
SMART errors.

Use the BIOS Configuration Utility to
create the array.

The system already has a
maximum of eight arrays

Delete unused arrays.

CAUTION: Deleting an array
permanently destroys all data that is
on the array. This action cannot be
undone and it is very unlikely the data
can be recovered.
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Table 36. An Array is in a Critical State

Possible Causes Additional Information Corrective Actions
One or more disks in the |Due to the failed disk or disks, the array is no See Section 8.5.1,
array have failed or been |longer maintaining redundant (mirrored or parity) |Troubleshooting Disks,
removed. data. on page 124.

The failure of an additional disk results in an
Offline state and lost data.

Table 37. An Array is in an Offline State

Possible Causes Additional Information Corrective Actions
The array has lost the One or more disks have failed. See Section 8.5.1,
maximum allowable e If the array is non-redundant, the failure of a | Troubleshooting Disks,
disks per RAID level. single disk causes the array to fail. on page 124.

e [fthe array is redundant, the failure of two or
more disks causes the array to fail.

The array cannot be restored (rebuilt).

Table 38. Cannot Assign a Dedicated Spare to an Array

Possible Causes Additional Information Corrective Actions

The RAID level does not |Dedicated spares cannot be created for e  Create an array with a different
allow dedicated spares.  |Volume or RAIDO arrays. RAID level and assign a
dedicated spare.

e Create a global spare.

The designated disk does | The capacity of the disk selected to be a |Select a different disk.

not have sufficient dedicated spare must be equal to or
capacity to be a dedicated |larger than the capacity of the smallest
spare disk in the array.
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Table 39. Cannot Create a Global Spare

AMD-RAIDXpert2 User Guide

Possible Causes

Additional Information

Corrective Actions

The disk is already part
of an array

A global spare cannot be selected if it
is already part of an existing array.

Select a different disk.

There are no empty disks
available or the disks
have not been initialized

A disk with a legacy state can be
initialized, if desired, but it is no
longer legacy (initialization adds

RAIDXpert2 configuration
information to the disk).

Install additional disks.
Initialize the disks.

all data on the disk is lost.

The disk assigned as the
global spare has failed or
IS missing.

See Section 8.5.1, Troubleshooting
Disks, on page 124.

Table 40. Recreate a Deleted Array

Possible Causes

Additional Information

Corrective Actions

An array(s) was
accidentally deleted, or
the wrong array was
deleted

This procedure might
recreate a deleted array and
with its data intact.
However, this is not
guaranteed to occur.

If I/0 was running to the
deleted array(s) just prior
to it being deleted, there
might be some data loss in
the recreated array(s).

If multiple arrays were
deleted, all of the deleted

arrays must be recreated in |

order to recover the desired
array.

At the Array pop-up menu, select Create.

Create a new array using the same settings

as the deleted array.

The same disks.

The same RAID type (RAID level).
The same capacity.

The same cache options.

Check Leave Existing Data Intact.
Click Create.

Ensure the settings are the same as the
deleted array:

The same drive letter.

The same RAID type (RAID level).
The same disks.

The same capacity.

The same cache option

Check the data files of the array for
corrupted or missing files, incorrect file
extensions, and so on.

Chapter 8
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8.5 Disk Related Errors

e Table 41. Disk Errors
e Section 8.5.1, Troubleshooting Disks, on page 124.
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Table 41. Disk Errors

Possible Causes

Additional Information

Corrective Actions

A disk has been removed from
an array

A disk is not visible in the
BIOS Configuration Utility or
is offline

See Section 8.5.1,
Troubleshooting Disks, on page
124,

A disk is highlighted red at the
BIOS Configuration Utility

The disk has failed.
Depending on the RAID level of
the array, data might be lost.

RAIDXpert2 cannot
communicate with the spare

The dedicated spare is not visible
in the BIOS Configuration Utility
or is offline.

The disk cannot be initialized

Only disks that are Ready can be
initialized.

CAUTION: When a disk is
initialized, all data on the disk is
lost.

Ensure the disk is not already
a member of an array.

o Ensure the disk is still
assigned as a global or
dedicated spare.

e Ensure the disk is reporting a
Ready state.

8.5.1

Troubleshooting Disks

Perform the following actions when there may be a problem with a disk.

e Ensure there is no damage to the system’s backplane.
e Ensure all cables are installed correctly.
e Ensure the disk is seated correctly in the backplane or bay and the latch is secured.

e Reinsert the disk.
¢ Replace the disk.

e After reconnecting, reseating, reinserting, or replacing a disk:

Perform a rescan.

Initialize the disk.
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CAUTION: When a disk is initialized, all data on the disk is lost.

AMD-RAIDXpert2 User Guide

If problems with a disk have caused an array to go Critical, it may be necessary to also assign a
dedicated or global spare for the array.

If problems with a disk have caused an array to go Offline, data may have been lost. Recover lost
data from a backup storage source.

8.6

Troubleshooting the RAIDXpert2 GUI

Table 42. RAIDXpert2 Graphical User Interface (GUI) Troubleshooting

Table 42. RAIDXpert2 Graphical User Interface (GUI) Troubleshooting

Problem

Possible Cause

Corrective Actions

License Level 0 when logging
in.

The RAIDXpert2-CGl (rc_cgi)
service stopped working or not
running.

Restart the rc_cgi service.

Cannot reach this page or
similar.

The Apache service has stopped
working or not running.

Restart the Apache service.

GUI blank, no array or disk
information.

Array name contains a forbidden
character.

Open a Command Prompt in
Windows.

Type cd C:\Program Files
(x86) RAIDXpert?2

Enter the following command:
rcadm.exe -M -n
“NewName” -a #

Where # is the Array that has the
forbidden character in its name.

Press Enter.
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Chapter 9 Safety Precautions

9.1 General

This section includes general safety precautions and specific RAIDXpert2 cautions. Read and
keep this user manual for future reference.

9.2 Safety Definitions

CAUTION: Indicates that failure to follow directions could result in damage to equipment or
data.

IMPORTANT: Provides clarifying information or specific instructions.
Note: Provides additional information.

TIP: Provides helpful hints and shortcuts.

9.3 Caution Messages

This section lists the Caution messages that appear in this user guide.

9.3.1 Caution Messages About Disks

CAUTION: Assigning a dedicated spare does not reserve space on the disk. Therefore, an
automatic restore is not guaranteed if a disk fails. If a disk fails, make space on the
disk for the fail-over to complete, or assign a different disk with enough space. If a
dedicated spare is assigned and a disk fails, the restore process starts automatically,
if there is enough space available on the dedicated spare.

CAUTION: If a disk is part of an AMD-RAID array, the disk cannot be selected for initialization.
To initialize the disk anyway, delete the AMD-RAID array. Data on the disk is deleted
during initialization so ensure the correct disks are chosen to initialize.

CAUTION: A legacy disk can contain valid data. When a legacy array is deleted, or when its
corresponding legacy disk is initialized, the data is lost.

CAUTION: When a disk is initialized, all data on the disk is lost.
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932 Caution Messages about Arrays

CAUTION: Deleting an array permanently destroys all data that is on the array. This action
cannot be undone and it is very unlikely the data can be recovered.

CAUTION: Do not delete the first array listed if it is the AMD-RAID bootable array. Doing this
deletes the operating system and AMD-RAID files.

CAUTION: Do not initialize a disk that is part of an array. Initializing a disk in a non-redundant
array deletes the array and its data. The array no longer appears in Array View. This
is especially true for a non-redundant bootable array. Initializing a disk in a non-
redundant bootable array causes the array to Fail and deletes the operating system,
AMD-RAID files, and device drivers.

CAUTION: Leaving Write Back Cache enabled for disks can increase the likelihood of data being
corrupted if the system experiences a power interruption or unexpected shutdown.

CAUTION: Prior to removing an array, unmount the array Linux®.

CAUTION: All data contained in a AMD-RAID array are lost if the disks of the array are
migrated to a non-AMD-RAID system.

CAUTION: When an array is securely erased, the data on the array is lost. The array remains
hidden after the secure erase completes. User must Un-hide the array for data
operations.

CAUTION: In some circumstances, more than eight arrays are possible. They might appear to
function properly but are not supported.

CAUTION: If the user creates an Array with Skip Initialization, the array will not be redundant.

CAUTION: Controller support for AMD SP3 compatible processors are as follows:
7 NVMe + 4-SoC when x570/590 is set to RAID in the BIOS
8-NVMe + 2-SoC + 1-PT when set to RAID in the BIOS
10-NVMe when SoC and PT are Disabled in the BIOS
10-NVMe + 1-PT when SoC is Disabled in the BIOS
9-NVMe + 2-SoC when PT is Disabled in the BIOS

CAUTION: Hot-Swapping is not recommended for disks that are part of AMD-RAID array.
CAUTION: AMD SP3 compatible processors support a maximum of 14 SATA ports on the system

depending on customer platform design (8 from PT SATA controller, 6 from AMD
SATA controller including devices connected to M.2 port).
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CAUTION: Maximum number of disks (both NVMe and SATA) that can be used for
Creating/Transforming a Volume, RAID-0, RAID-5, and RAID-10 arrays is eight. For
RAID-1 only two disks are supported.

CAUTION: RAID on AMD platforms support M.2 ports, both on the SATA controller and PCle
M.2 NVMe. At any given time, each M.2 port can support either M.2 SATA or M.2
NVMe, but not both.

CAUTION: Individual disks which are not part of a RAID array will not be listed in Device
Manager under the Disk Drive section. Individual Disks can be managed through
RAIDXpert2 management utility, HIl and the EFI shell.

CAUTION: If a user wants to add or remove a NVMe into a system, it is AMD’s recommendation
that a reset of the system is performed, wait for the BIOS screen to appear, then power
off the system and add or remove the NVMe(s).

CAUTION: A Native AHCI installation will not boot into the OS, after changing the BIOS
settings to RAID mode.
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Chapter 10  Software License: EULA

10.1  Software License: End-User License Agreement
(EULA)

BY INSTALLING, DOWNLOADING AND/OR USING THE SOFTWARE THAT
ACCOMPANIES THIS END USER LICENSE AGREEMENT (“AGREEMENT”) AND ANY
ASSOCIATED DOCUMENTATION OR UPDATES THERETO ("SOFTWARE"), YOU
AGREE THAT, WHETHER AS AN INDIVIDUAL OR AUTHORIZED REPRESENTATIVE
OF AN ENTITY, YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT AND AGREE
TO BE BOUND BY IT. IF YOU DO NOT AGREE TO IT, YOU ARE NOT AUTHORIZED TO
INSTALL, DOWNLOAD OR OTHERWISE USE THE SOFTWARE AND ARE ASKED TO
PLEASE RETURN THE SOFTWARE TO THE PARTY FROM WHOM YOU RECEIVED IT.
THE RIGHT TO USE THE SOFTWARE IS GRANTED ONLY UPON THE CONDITION
THAT YOU AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT.

FURTHER, YOU UNDERSTAND THAT THIS SOFTWARE MAY ONLY BE OBTAINED
FROM Advanced Micro Devices, Inc. (“AMD”) OR AN AUTHORIZED DISTRIBUTOR OF
AMD. IF YOU OBTAINED THIS SOFTWARE FROM ANY OTHER SOURCE, THAT
SOURCE PROVIDED IT TO YOU ILLEGALLY, AND YOU HAVE NO RIGHT TO
INSTALL, DOWNLOAD OR OTHERWISE USE THE SOFTWARE; SUCH USE IS A
VIOLATION OF INTELLECTUAL PROPERTY RIGHTS.

10.1.1 Limited License to Authorized Distributors

If you are an OEM, distributor, reseller, integrator or other entity in the business of providing
technology products and/or services, and if you have been expressly authorized to distribute copies
of the Software to End User(s), you are an "Authorized Distributor.”" Subject to the terms and
conditions of this Agreement, you are granted a limited, non-exclusive, non-transferable, non-sub
licensable license to distribute and/or install the Software in its unaltered, object code form solely
(i) to, and on behalf of, a purchasing End User for the End User’s internal business purposes; and
(ii) only for use with one (1) AMD product, purchased through authorized AMD sales channels.
Except as specifically stated in this Section 1, Authorized Distributors are expressly prohibited
from: copying and/or distributing the Software in whole or in part; using the Software to provide
consulting or other services to third parties; and distributing the Software in any form or format.
Authorized Distributors are subject to all other terms and conditions of this Agreement.
Authorized Distributors must ensure that its End Users see and agree to this Agreement.
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10.1.2 Limited License to End Users

If you have licensed the Software for your own personal use or your company's internal use, you
are an "End User." You are hereby granted, subject to the terms and conditions of this Agreement,
a limited, non-exclusive, non-transferable, non-sublicensable license to use this Software in its
unaltered, object code form solely (i) for internal business purposes; and (ii) only with respect to
one (1) AMD product that was purchased through authorized AMD sales channels. Further, you
must obtain this Software only from authorized AMD sales channels. Obtaining it from any other
source is a violation of the intellectual property rights of AMD and its licensors.

10.1.3 Restrictions

Except as expressly authorized in Sections 1 and 2 above, Authorized Distributors and End Users
(collectively "You”) shall not (nor cause or permit any other person to): (i) reverse engineer,
translate, disassemble, derive source code from, decompile, rent, lease, manufacture, adapt, create
derivative works from, or otherwise modify or distribute the Software or any part thereof; (ii)
copy, in whole or in part, the Software with the exception that only End Users may make one copy
of the Software for their backup or archival purposes; (iii) publicly display the Software or use the
Software to provide consulting or other services to third parties; or (iv) delete any copyright,
trademark, patent or other notices of proprietary rights as they appear anywhere in or on the
Software.

10.1.4 Proprietary Rights

The Software is primarily the intellectual property of Seagate Technology PLC. (“Seagate”) and
its licensors (“Licensors”). In no event shall You obtain title to the Software or any component
thereof. As between Seagate and You, Seagate has all rights, title, interest, ownership and
proprietary rights in and to the Software. Seagate's rights include, but are not limited to, all copies
of the Software and any patent rights, copyrights, trademark rights, trade secret rights, and any
other intellectual property right recognized in any country or jurisdiction in the world.

The Software is protected by both United States law and international treaty provisions.

All rights not expressly granted in this Agreement are reserved by Seagate and Licensors,
respectively.

Certain modifications to the Software are the intellectual property of Advanced Micro Devices,
Inc. As between AMD and You, AMD has all rights, title, interest, ownership and proprietary
rights in and to those modifications including but not limited to any patent rights, copyrights,
trademark rights, trade secret rights, and any other intellectual property right recognized in any
country or jurisdiction in the world.
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10.1.5 Terms and Conditions

This Agreement shall continue in effect until terminated. AMD may terminate this Agreement
immediately if You fail to comply with any provision of this Agreement. Upon termination, You
shall discontinue use of the Software, and either destroy, erase, or return all copies of the Software
in Your possession or control.

10.1.6 No Warranty

THE SOFTWARE IS PROVIDED "AS IS" WITHOUT ANY WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED. SEAGATE AND AMD DISCLAIM, ON THEIR OWN BEHALF
AND ON BEHALF OF LICENSORS, ANY EXPRESS OR IMPLIED WARRANTIES
INCLUDING ANY IMPLIED WARRANTIES OF NONINFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OF THE SOFTWARE
OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR
ERROR-FREE OR WILL OPERATE IN COMBINATION WITH OTHER SOFTWARE OR
HARDWARE. Seagate and its Licensors will not provide support for the Software and, to the
extent you believe that are entitled to support, you are advised to contact the party from whom you
received the Software. Notwithstanding the foregoing, Updates to the Software (which may or
may not be distributed) shall be governed by this Agreement, and such Updates will be considered
Software for purposes of this Agreement.

The Software is not absolutely fault-tolerant and is not designed, manufactured or intended for use
or resale as on-line control equipment in hazardous environments requiring fail-safe performance
in which the failure of the Software could lead directly to death, personal injury or severe physical
or environmental damage, such as the operation of nuclear facilities, aircraft navigation, air traffic
control, direct life support machines, or weapons systems (“High Risk Activities”). Express or
implied warranties for High Risk Activities are specifically disclaimed.

10.1.7 Limitation of Liability

IN NO EVENT SHALL SEAGATE, AMD OR LICENSORS BE LIABLE TO ANY PARTY
FOR ANY LOST REVENUE, LOST PROFIT OR DATA, OR FOR SPECIAL, INDIRECT,
CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED, AND
REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OF OR
INABILITY TO USE THE SOFTWARE EVEN IF THEY HAVE BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL SEAGATE’s, AMD’s or
LICENSORS’ LIABILITY, TO YOU, WHETHER IN CONTRACT, TORT (INCLUDING
NEGLIGENCE) OR OTHERWISE, EXCEED THE AMOUNT OF ANY FEE PAID BY YOU
FOR THE SOFTWARE. THE FOREGOING LIMITATIONS SHALL APPLY EVEN IF THE
REMEDY FAILS OF ITS ESSENTIAL PURPOSE. Some jurisdictions do not allow for the
exclusion of implied warranties as described in Section 6, or the limitation of liabilities as
described in this Section 7, so the above exclusions or limitations may not apply to You. In that
event, to the extent permissible, any exclusion of warranties or limitation of liability will be
limited in duration or type to the greatest extent allowed by law.
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10.1.8 Export Controls

You agree to comply fully with all relevant export laws, regulations, treaties, and orders ("Export

Laws") to assure that neither the Software nor any components thereof are (i) exported, directly or
indirectly, in violation of Export Laws; or (ii) are intended to be used or are used for any purposes
prohibited by the Export Laws.

10.1.9 General

This Agreement and any disputes arising from or relating to it shall be governed by and construed
in accordance with the laws of the State of Colorado without reference to conflict of laws
principles and excluding the U.N. Convention on Contracts for the International Sale of Goods.
Any legal action or proceeding shall be instituted in a state or federal court in Denver, Colorado,
U.S.A. and You agree to be subject to the jurisdiction of these courts. Taxes and charges imposed
by any government with respect to the Software shall be paid by the End User. The waiver by
either party of a breach of this Agreement or a failure to exercise any right hereunder shall not
operate or be construed as a waiver of any subsequent breach or as a waiver of any other right. If
any provision of this Agreement is held to be unenforceable or overbroad for any reason, it will be
modified rather than voided, if possible, in order to achieve the intent of the parties to the extent
necessary to make the provision enforceable under applicable law and enforced as amended. In
any event, all other provisions of this Agreement will be deemed valid and enforceable to the full
extent. This Agreement constitutes the complete agreement between the parties and supersedes all
prior or contemporaneous agreements or representations, written or oral, concerning the subject
matter of this Agreement including any purchase order or ordering document. This Agreement
may not be modified or amended except in writing and signed by both parties.
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Appendix A Browser Setup

Browser Setup

e Use Chrome version 20, Firefox version 14, Internet Explorer 8, or Safari 6, or a greater
version of each.

e To optimize the display, use a color monitor and set its color quality to the highest setting.
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